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Introduction to the FluorChem Systems and AlphaView Software
The FluorChem Systems are designed to meet the requirements of the most demanding chemiluminescence 
assays and also provide the most versatile fluorescence imaging system available today. These systems inte-
grate the latest developments in camera and lens technology for imaging chemiluminescent and fluorescent 
samples with a wide dynamic range and fast image acquisition speeds.

The system is controlled by easy-to-use and intuitive AlphaView! software which performs image analysis and 
archiving and can also prepare images for desktop publishing. 

AlphaView software includes image optimization tools that adjust contrast automatically or manually. Convert-
ing the image from positive to negative, using digital filters, applying a false color map, or other such tech-
niques can be used to clarify hard-to-see portions of the image. Notes, labels, arrows, lines, and other drawing 
tools can be recorded directly onto the image using AlphaView software’s annotation functions. Annotations 
are superimposed on the image upon hard copy printing and can either be saved as a template file or as part 
of the image. All AlphaView features are accessible via convenient on-screen buttons and menus in an intui-
tive, mouse-controlled interface.

AlphaView software also includes a broad array of analysis tools, including molecular weight calculation, Rf 
determination, lane profile, band analysis, quantitative PCR, microtiter plate reading, object distance 
measuring, gel scoring, and automatic colony counting.

FluorChem systems include all the necessary hardware and software for image capture, enhancement, and 
analysis. AlphaView software does not require a dedicated computer system and can operate simultaneously 
with other office-related software, such as word processing programs, spreadsheets, and desktop publishing 
software.

Images can be printed using a 256-level gray scale thermal printer or any printer with a Windows! driver. The 
low-cost, high-quality prints are ideal for lab notebook records or publication. 

The “AlphaView System Quick Guide” on page 42 provides a condensed instruction sheet that acts as a quick 
reference guide for users already familiar with the software. Keeping copies of the appropriate instruction 
sheet(s) near the system for easy reference is highly recommended.

Mouse Functions

The system comes packaged with a two-button mouse. The left button activates functions and makes selec-
tions when using the software. In some cases, the right mouse button can recall or reactivate the function that 
was most recently assigned to the left mouse button. 

Starting AlphaView Software

To start AlphaView software, double-click the AlphaView software icon on the Windows desktop.
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About This Manual
This manual uses different fonts to indicate certain conditions:

• Bold text indicates the name of a button, a menu, or a function found in a menu.

• Courier text indicates an entry that is typed.

• Letters or words found between < > refer to keys on the keyboard.

• NOTE indicates key points and useful hints.

• CAUTION and !WARNING! statements indicate actions that may either harm the system or user, 
or affect the data quality.

• Icons or buttons to be pushed are placed next to their respective descriptions in the text.

Customer Service and Technical Support 
The Cell Biosciences staff is available to respond to any questions or comments about the software. For ques-
tions, new software feature ideas, or general feedback, use the following contact methods:

Telephone
(408) 510-5500 
(888) 607-9692 (toll free) 

Fax
(408) 510-5599

E-mail
support@cellbiosciences.com

Web
www.cellbiosciences.com

Address
Cell Biosciences, Inc. 
3040 Oakmead Village Drive 
Santa Clara, CA 95051
USA



page 4 Chapter 1: Introduction and Setup

FluorChem HD2 and FC2 User Guide

FluorChem System Setup

System Components

The FluorChem systems include the following:

• High-performance, high resolution, CCD camera

• Manual f/2.8 28-70mm zoom lens or other optional lens

• Computer with keyboard, mouse, and monitor (optional)

• Windows operating system (pre-installed)

• AlphaView image processing and analysis software (pre-installed and calibrated with computer and 
hardware system)

• MultiImage! II FC light cabinet containing a UV transilluminator, white light fold-down transilluminator 
and epi white lights with interference filter

• Fast lens (optional)

• Epi-illuminating UV lights (optional 254nm or 365nm)

• Printer (optional)

• ChromaLight (optional)

Upon receiving the system, it is critical to check the enclosed packing list to verify that all components are 
properly included.

System Placement

As with all electrical instruments, the FluorChem systems should be located on a table or bench top that is 
dry and stable, and away from water, solvents, or corrosive materials. In addition, the system should be placed 
away from interfering electrical signals and magnetic fields. If possible, a dedicated electrical outlet should be 
used to eliminate electrical interference from other laboratory instrumentation.

Cable Connections

The cable connectors and their respective mating ports are keyed or unique for each connection to eliminate 
potential wrong mating. The connections are illustrated and described later in this chapter.

!WARNING! 
Make sure that the power is OFF and all power cords are disconnected while connecting the cables 
and setting up the system.



FluorChem System Setup page 5

FluorChem HD2 and FC2 User Guide

Hardware Installation 

All software, peripheral drivers, and operating systems come factory-installed on computers purchased 
directly from Cell Biosciences. All components must be mated only to their correct ports during system instal-
lation.

Power Strip/Surge Protector Setup

Turn the power strip/surge protector power switch off. Plug the power strip/surge protector into a wall outlet 
(preferably a dedicated circuit) and turn the power on. 

CAUTION 
Do not plug the DE-500/DE-500 FC MultiImage II light cabinet into the same power strip as the
FluorChem system. Using a separate circuit is highly recommended. The cabinet must be turned on 
after the computer’s operating system has launched for the software to function properly. 

Computer, Monitor, Mouse, and Keyboard Setup

The computer must have the monitor, mouse, and keyboard connected in the correct ports (see Figure 1-1). 
A standard three-prong power cable should be plugged into the back of the computer and the power strip.
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Figure 1-1: Computer, Monitor, Mouse, and Keyboard Setup

Connect the monitor’s video cable to the monitor port on the back of the computer. If after-market video 
cards were preinstalled into your computer system, connect the monitor’s video cable to the video card 
connector. Connect the monitor’s power cable to the power strip.

The mouse and keyboard connectors are color-coded and icon identified. Attach the mouse and keyboard 
cables to the connectors on the back of the computer by matching the colors. Some systems have USB 
mouse and keyboards.

The computer is now ready to be turned on. Turn the computer on by pushing the power button on the 
front of the unit.
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Cabinet Installation Instructions

Figure 1-2: MultiImage II Light Cabinet (DE-500)—Pictured with the cabinet top (DE-500FC)

Cabinet Setup
When you remove the light cabinet from its shipping carton, it is already partially assembled. The camera 
mounting assembly is packed separately in the same container. The UV transilluminator and cabinet top are 
both packed in separate boxes. Make sure you have received all the hardware before discarding the shipping 
carton.

1. The largest box will be the DE500 cabinet. This box will include camera bracket, camera bracket
gasket, RS-232 cable, magnetic pad and pen.

2. Set the entire cabinet assembly on a level, flat surface. (There are indentations to the bottom of the 
cabinet, please use them for lifting and placement of the unit. The cabinet weighs 80 lbs with the UV 
transilluminator please take appropriate precautions in lifting and moving the light cabinet.) The footprint 
dimensions for the cabinet is 20” wide X 14” deep.

3. Open door and remove shipping foam from above and below fold down white light table. 
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NOTE: The camera bracket, gasket, RS-232 and magnetic pad/pen will be located in and around the 
shipping foam. Fold up white light table. 

NOTE: Be sure to remove the inserts from the white sidelight bulbs. 

4. Slide out UV tray. Unpack UV transilluminator and mount onto sliding tray (be sure to align UV 
transilluminator rubber feet into sliding tray open positions). Inside the cabinet, locate the power cord 
taped with RED tape. Uncoil and insert into the power socket for the UV transilluminator. (Additionally: if 
installing ChromaLightTM, use the BLUE taped power cord for the transilluminator.)

5. Plug the light cabinet into the surge protector, turn on the cabinet, and test each of the switches on the 
front of the cabinet to ensure that all connections were made properly. 

NOTE: Do not plug a transilluminator or the MultiImage II light cabinet into the same power strip as the 
computer; use a different circuit whenever possible.

6. AlphaView provides cabinet controls through the software. An RS-232 cable that is supplied with the 
cabinet is required for this purpose. Locate the RS-232 cable insert it into the corresponding socket, next 
to the power connect, and power switch on the rear of the DE500 (see Figure 1-3).

Figure 1-3: Cabinet Setup

The DE-500 and DE-500FC MultiImage Light cabinets connect to the back of the computer via an RS-232 
cable. 
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!WARNING! 
If equipment is used in a manner not specified by the manufacturer, the protection provided by the 
equipment may be impaired.

CAUTION
The power supply cord is used as the main disconnect device. Ensure that the socket-outlet is 
located/installed near the equipment and is easily accessible.

Table 1-1: System Symbols

!WARNING!
Please use protective equipment when using UV light. UV protective goggles, face shields, long sleeve 
lab coats can be obtained from major scientific distribution catalogs (e.g. Fisher Scientific).

Symbol Description

Ultraviolet Light

Risk of Electric Shock

Hazard—Take Appropriate Precautions

Earth (Ground) Terminal

Fuse Symbol
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Power Ratings:

DE 500FC MultiImage II cabinet is rated at:

250V 50/60 Hz 3A

Fuse: 250V 3.15A

Camera Components and Installation

Motorized Lens (Optional)
Figure 1-4 illustrates the different camera components for the motorized zoom lens (optional) for the 
FluorChem HD2.

Figure 1-4: Camera Components

The following steps detail the installation and setup process:

1. Use an Allen wrench to attach the motorized lens bracket to the top of the DE-500 cabinet with the four 
screws provided.
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Figure 1-5: Camera Installation—Step 1

2. Place the o-ring in the middle of the bracket.

Figure 1-6: Camera Installation—Step 2

3. Place the motorized optics onto the bracket, carefully aligning it on top of the two protruding studs. The 
motorized optics and should fit perfectly. Once on top, use the two fasteners to secure the motorized 
optics.
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Figure 1-7: Camera Installation—Step 3

4. Place and secure the camera on top of motorized optics.

Figure 1-8: Camera Installation—Step 4
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CAUTION
Install two ¼”-20 x 1/4” button head screws on the camera sides to prevent light leaks. Do not use 
screws longer then 3/8” or the camera will be damaged.

1. Connect the camera cable and the camera power supply connectors to the back side of the camera. 

Figure 1-9: Camera Setup—Step 1

2. Connect the power cable standard three-prong end to the power strip.

Figure 1-10: Camera Setup—Step 2
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3. Complete the installation by connecting the camera cable to the USB port. 

Figure 1-11: Camera Setup—Step 3

Connecting the Printer

The Mitsubishi P95DW (UB) printer connections are color-coded for convenience. Plug the USB cable into 
the back of the printer and into the proper USB connector on the back of the computer. Plug in the standard 
three-prong power cable to the back of the printer and to the power strip, then turn the power on.

NOTE: The printer may be connected to any USB port on the computer ; however, the driver may need to 
be manually re-installed depending on which USB port is used. 

The Mitsubishi CP700 and CP770 printers connect via the on-board parallel (LPT1) port. Plug in the standard 
three-prong power cable on the back of the printer and into the power strip, then turn the power on. Set the 
printer up for color or black and white printing following the directions in the owner’s manual supplied with 
the printer. 

Power Up Sequence

Once all connections are made between computer, cabinet, camera, printer and monitor power can be 
applied in the following sequence:

1. Monitor

2. Computer

3. DE500 cabinet

4. Camera power supply—the camera will begin to cool to -10 °C.

5. Printer

After the cabinet filter wheel has finished homing, launch AlphaView software to begin deep cooling of the 
camera (minimum cooling period is 30 minutes).
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Starting the FluorChem System with AlphaView Software

To launch AlphaView software, double-click the AlphaView icon on the Windows desktop.

System Information

To display system information, click Help > About. This option accesses a pop-up box (see Figure 1-12). 

Figure 1-12: System Information

This box shows the software version number. Use the information specific to your instrument and software 
when calling Cell Biosciences for technical support and software upgrades.

To close the box, click OK.
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Chapter 2:

Getting Started—Basic Imaging 
Functions

Chapter Overview
• Basic Imaging Functions

• Automatic Image Capture (AIC) Software–Optional

• AlphaView System Quick Guide

• Contrast Adjustments

• Imaging Tools
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Basic Imaging Functions
Power up the system computer and click on the AlphaView icon on the desktop to open AlphaView soft-
ware. 

Figure 2-1: AlphaView Screen—Displaying the Image Area and Display Controls

AlphaView software has four main control areas:

• Acquire for image acquisition

• Contrast Adjustments for image adjustment

• Enhancement Tools for image enhancement

• Analysis Tools for image analysis

Acquiring an Image Using the Navigator 

Clicking the Navigator toolbar icon will guide the user through commonly used applications; in this 
example procedure, the “Ethidium Bromide” application is demonstrated.
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Figure 2-2:  AlphaNavigator—Selecting the Yes Option

Selecting the “Yes, …” option displays the following dialog box.

Figure 2-3: Selecting the Sample Type

NOTE: The supported applications depend on the product.

Selecting Gel displays the following screen:
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Selecting Nucleic Acid displays the following screen:

Figure 2-4: Selecting the Ethidium Bromide Stain Option

Choosing Ethidium Bromide will select the proper light source and filter needed. The acquisition screen in the 
preview mode is displayed with the Auto Expose option selected.
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Figure 2-5: Previewing Your Image

AlphaNavigator displays navigation notes. Click on the Advanced button to access more acquisition controls, 
or click Next to acquire. If the Advanced button is selected:
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Figure 2-6: Advanced Mode—Accessing Acquisition Controls

The user can modify any control, hit Next to acquire, or Back to return to the preview mode.

If Next is selected the following screens are displayed:

Figure 2-7:  Image Acquisition Confirmation Prompts

Selecting the Yes option and clicking Next will give a save protocol dialog box. The protocol will be added to 
the list of existing protocols.

Selecting the No option and clicking Next will generate the save image dialog box:
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Selecting the Yes option and the clicking the Finish button will generate the save image dialog box and exit the 
Navigator. Selecting the No option, will close the Navigator.

The next time the Navigator is run, the user can run the saved protocol:

Figure 2-8: Running the Saved Protocol

Selecting the No option, the following screen is generated with the last saved protocol selected.

Figure 2-9:  Selecting the Saved Protocol

The user can browse for other saved protocols by clicking on the down arrow. A list of existing protocols will 
be displayed:
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Figure 2-10: Selecting "My Eth. Boromide" Saved Protocol

Selecting the saved protocol will go to the preview screen for the user to verify or acquire the setting.

Acquiring an Image Using the Acquire Button

In the Tool Bar, click the Camera Acquire icon, which launches the Camera Setup and Preview 
window; see Figure 2-11.

Figure 2-11: Camera Setup and Preview Window
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This window provides camera exposure control, sensitivity/resolution control, lighting/filter wheel position 
control, contrast display options, and cabinet door status. The active imaging channels are laid out in a tabbed 
architecture. One tab for each channel that contains the complete acquisition configuration for that channel.

In addition, the system can enter Movie Mode by clicking the MovieMode button; see “Movie Mode,” starting 
on page 34. 

Focus Control Mode

This window opens in Focus control mode (blue button). Focus control mode provides near-real time 
readout for easy sample positioning and optics adjustments. While in focus, select the lighting, filter, and 
binning options appropriate for your sample. You can then focus on your sample, select an aperture setting, 
and focus on your image. 

NOTE: While in Focus control mode, we recommend clicking the Auto Expose check box to allow the 
software determine the optimal length of time for your image acquisition. 

Expose Preview

Clicking the green Expose Preview box allows you to preview what your final image would look like, while still 
allowing you to make small adjustments to the options you select in focus. 

Acquire Image

Select Acquire Image to capture your final image. You will then be able to save, print or analyze your image. 

Auto Expose

The AlphaView features an Auto Expose function for ease of use. The Camera Setup and Preview window 
includes a check box to activate the Auto Expose function, as well as a button labeled Auto Expose Setup to 
configure the function.
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Figure 2-12: Auto Expose

Figure 2-13: Auto Expose Compensation Setting

Clicking the Auto Expose Setup button launches the Auto Exposure Compensation Setting window. This 
window offers four options:

• Normal exposure for image saturation. This setting is ideal for normal Colorimetric and Fluorescent 
imaging.

• Under exposure for chemiluminescence

• Over exposure for faint band detection.

• Custom exposure compensation. This setting allows the user to define the Exposure Value (EV). The 
left set of up/down arrow buttons change the EV value by whole unit intervals while the right set of 
up/down arrow buttons change the EV value by 1/8-unit intervals.
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Auto Exposure works in both Preview and Acquire Image modes. The AlphaView software calculates the 
correct exposure time for the current situation. In Expose Preview mode, a status bar appears above the 
Auto Expose interface. In Acquire Image mode, a status window featuring a colored Auto Expose status bar 
for image acquisition appears. The status bar indicates the current status of the calculation. The status bar 
changes from red to yellow to blue to green to indicate progress. When it reaches green, the AlphaView soft-
ware has calculated the correct exposure time. For exposure time calculations with saturated pixels in the 
image area, the status bar changes to pink to indicate the issue. 

In Acquire Image mode, a green status bar indicates that the image is acquired. After achieving a green status, 
the new image loads and the Camera Setup and Preview window closes. In Expose Preview mode, the 
system continues repeated expose using the calculated exposure time until a different mode is selected. 

Switching from Expose Preview mode to Acquire Image mode does not reset the calculation. If the system 
changes from Expose Preview mode to Acquire Image mode after calculating the correct exposure time in 
Expose Preview mode, images are acquired using the last calculated exposure time. Similarly, if a different 
sensitivity (binning) mode is selected after finishing the exposure calculation, the calculation is quickly con-
verted and no recalculation is required.

The Exposure Value (EV) unit is the same as used in film photography (also called a “stop”). +1 EV will double 
the exposure time while –1 EV with halve the exposure time. The general exposure time using EV is found by 
the following formula:

(EVCompensatedTime) = Time*2EV

Where Time is the typical exposure time for the sample under test to reach full exposure as determined by 
the auto exposure tool.

Setting Exposure Time Without Auto Expose

Once the sample is positioned and the lens is properly focused, perform the following steps:

1. Close the MultiImage light cabinet door and check to ensure that the appropriate illumination source is 
turned on. In addition, check to ensure that the cabinet door indicator in the Cabinet Control software 
interface indicates Closed. 

2. Uncheck the Auto Expose option. 

3. Click on the green Expose Preview button and select the desired exposure time in to configure the 
system for the desired image intensity quality. Individual adjustments for milliseconds, seconds, minutes, 
and hours are available. The following list describes ideal exposure settings for different applications:

• For most white-light applications, using a 50 ms exposure is sufficient. Final aperture adjustments 
can be made to optimize the image quality. 

• For UV fluorescence applications, using an exposure range between 8 ms and 4 seconds is suffi-
cient. The aperture should be completely open when performing any adjustments. Selection Show 
Saturation is recommended for these applications.



page 28 Chapter 2: Getting Started—Basic Imaging Functions

FluorChem HD2 and FC2 User Guide

• For low-light applications, such as chemiluminescence, a longer exposure time may be appropriate. 
In these cases, push the red Acquire Image button to directly acquire the image upon setting the 
desired exposure time. If a good exposure time is unknown, an alternative method is to utilize the 
Auto Expose feature configured to super sensitivity. Auto Expose image generation – with signal 
intensity showing—generally completes in less than three minutes. After Auto Expose image 
generation, a different sensitivity (binning) mode can be selected to generate a better resolution 
image. For further images, the software automatically calculates the new exposure time.

NOTE: When the system switches to Expose Preview mode, the image may flash or change brightness due 
to camera photon collection from the image over a longer period of time prior to sending the image to the 
computer’s display readout.

Light Source and Filter Controls

The mechanical controls on the cabinet and the AlphaView software’s virtual cabinet control interface 
(labeled as Cabinet Controls) are linked and provide near-real time synchronization and updating of light 
source and filter selection. Selecting a desired option via the software interface produces the same result as 
using the physical controls on the cabinet. 

NOTE: A slight delay occurs upon pressing the button until the light source is fully activated. 

Standard lighting choices include:

• Transillumination White: Protein gels, autorads, film, plates, and flasks

• Transillumination UV: Fluorescent gels such EtBr, SYPRO Red, SYBR Safe, etc.

• Reflective White: Colorimetric blots and membranes

• Reflective UV (optional): SYBR green, TLC plates, and Chemifluorescence

• ChromaLight (optional): GFP, Fluorescein, and SYBR green

Filters selection is linked to appropriate sample visualization. 

Filter options include:

• Filter Position #1: Empty Position for Chemiluminescence detection

• Filter Position #2: Orange filter (595/55 nm) for Ethidium Bromide, colorimetric stains, film, SYPRO 
Orange

• Filter Position #3: Optional green filter (537/40 nm) for SYBR Green, SYBR Safe and Fluorescein

• Filter Position #4: Optional red filter (620/40 nm) for SYPRO Ruby, SYPRO Red and Deep Purple 

• Filter Position #5: Optional blue filter (460/40 nm) for Hoeschst Blue
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NOTE: If exposure time is less than 100 ms, yet signal is strong, close the aperture by stops.

Turbo Modes and Speed/Resolution Settings

The AlphaView System offers different speed and resolution settings to allow image acquisition across a 
variety of needs. Tweaking resolution and speed settings allow image acquisition to occur as quickly as 
possible, with the highest resolution possible, or somewhere in between. Available acquisition modes include 
5 binning modes and 2 Turbo modes.

Figure 2-14: Turbo Modes and Speed/Resolution Settings
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The camera modes are selected by the Turbo Mode check box. When the Turbo Mode checkbox is 
unchecked the camera operates in Normal mode. Normal mode is useful for those imaging applications that 
require wide dynamic and quantification of low signal intensities. When the Turbo mode checkbox is checked 
the camera operates in Turbo Mode. Turbo Mode is used for the applications that require fast image 
acquisition to quickly visualize samples even those with low signal intensities. 

Both Normal and Turbo mode can be used with each of five binning modes and Auto Expose functions to 
optimize image acquisition speed and for fluorescence and chemiluminescence applications.

Speed/Resolution Settings

Normal/Ultra Mode
Recommended for Fluorescence and Colorimetric Imaging, this mode captures the image using the CCD 
sensors full 2048x2048 pixel resolution to generate highest quality, vibrant images that are ready for 
quantitative analysis and publication.

Medium/High Mode
Recommended for Chemiluminescence, this mode captures images with a 2x2 pixel bin to decrease the 
required exposure time while maintaining a high resolution (1024x1024) image. This mode decreases 
exposure times from full resolution images by approximately a factor of four.

High/Medium Mode
Recommended for Chemiluminescence, this mode captures images with a 3x3 pixel bin (683x683 pixels) 
with decreased image acquisition time and medium resolution. This mode decreases exposure times from full 
resolution images by approximately a factor of nine

Fast/Low Mode
Recommended for Chemiluminescence, this mode captures images with a 4x4 pixel bin (512x 512 pixels) 
Similar to Super Speed this mode decrease exposure time but with a trade off in resolution. This mode 
decreases exposure times from full resolution images by approximately a factor of sixteen

Super Speed Mode
Recommended for Chemiluminescence, this mode captures the image performing an 8x8 pixel bin (256 x 
256 pixels). This mode significantly decreases the exposure time required for acquiring a long 
chemiluminescent exposure. This mode’s resolution is set to 256x256 pixels and is not recommended for 
precise quantitative analysis or publication. Super Speed mode is ideal for Expose Preview functionality when 
using Auto Expose to determine the chemiluminescent blot signal level. It is also useful for rapid visualization 
of signals for a qualitative assessment of the sample.
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Gray Scale Optimization for Saturation and Contrast Displays

Figure 2-15 illustrates the check boxes available for modifying the displayed image.

Figure 2-15: Modifying the Displayed Image

Any images set for analysis must not be over-exposed (too light) or under-exposed (too dark) for maximum 
clarity. Using the Show Saturation option (located below the camera control functions) displays the image 
areas assigned to each end of the gray scale spectrum. After inspecting the image’s saturation, the imaging 
controls can be adjusted accordingly to optimize the image.

The Show Saturation option allows the user to access the Saturation Palette during image acquisition. The 
Saturation Palette is a modified gray scale palette in which green replaces black (gray level 0), and red replaces 
white (gray level 255, 4,095, or 65,535). With this palette, the image’s over- and under-exposed areas appear 
as green or red, while areas within the linear range of the CCD chip appear in gray scale. 

During image acquisition, it is critical to note the image’s regions that appear red or green. The exposure time 
and the camera aperture can be adjusted to minimize the amount of red and green in the image area. 
Eliminating red and green in the actual sample area is especially critical for images that will be quantified. The 
saturation view can be turned off by unchecking Show Saturation once the red and green areas have been 
minimized and/or eliminated 

The other three selections (Chemi Display, Auto Contrast, and Reverse) act as visualization tools designed to 
enhance contrast and provide flexibility image viewing. The Auto Contrast option displays the image with 
automatic black, white, and gamma adjustments according to the image histogram information (black/white 
levels). Reverse shows the sample as a negative by switching the black and white values. The Chemi Display 
option utilizes both auto contrast and reverse functions, as well as providing gamma adjustments, and is 
intended for use with chemiluminescent samples. 

NOTE: These options are also available in the Movie Mode. 

NOTE: These Contrast Display options are only visualization tools and do not change any image data 
acquired by the CCD camera.
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Zoom ROI Tool

Zoom ROI is a tool designed for use with fast or fixed focal length lenses. These lenses typically have lower 
F-stop numbers than zoom lenses, but do not have zoom capabilities. Fast lenses are most commonly used to 
decrease exposure times in chemiluminescence applications. However, they can also be used for other 
applications, such as fluorescent gels. Since fixed focal length lenses do not have zoom rings, adjusting an 
acquired image’s region of interest is possible using the AlphaView software interface.

When the sample’s region of interest is smaller than the acquisition window’s and the system is not equipped 
with a zoom lens, the zoom ROI tool provides an ideal workaround. The Zoom ROI tool allows for 
software-based zooming without having to switch lenses. To use the Zoom ROI tool, focus on the image, then 
position the Zoom ROI slider until the region of interest occupies the preview window’s entire image area. 
Use the Expose Preview and Acquire Image buttons to configure and acquire the final image. The Zoom ROI 
tool eliminates the need for cropping an image down to a desired size post-acquisition.

Figure 2-16:  Zoom ROI Tool
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Saving Images

Once a satisfactory image has been captured, it should be saved as an original file for safe archiving. Click 
File > Save As or click the Save or Save As icons.

Super-OD Acquisition Feature 

Super-OD" is a process that delivers full dynamic range performance for digital imaging applications. 
Super-OD acquisition accomplishes this by extending the range of different light (or brightness) levels from 
the sample that can be viewed as a single image beyond that of a standard image. Super-OD acquisition can 
produce an image that represents more than 100-fold extension of the brightness range. 

Figure 2-17: Super-OD Acquisition Feature Window

The AlphaView acquisition window contains a Super-OD slider bar located above the image window display. 
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Acquiring in Super-OD Acquisition Mode 
The user may acquire a Super-OD image with a factor from 2 to 500. Choose the Super-OD factor to use by 
sliding the Super-OD slider bar to the right. Super-OD acquisition is activated whenever the Super-OD slider 
is in any position other than “Off ”. As the slider bar is moved to the right the “Super-OD Factor” will increase 
and be displayed. 

Figure 2-18:  Super OD Slider

In addition to the Super-OD Factor, the software also shows a time estimate for the total acquisition time. 
This time estimate is displayed as “Time x ‘value’” where ‘Time’ is the initial exposure time and the ‘value’ is 
the multiplier to achieve the chosen Super-OD Factor. In the example above, the Factor is set to 8. The total 
acquisition time will be 544 times the initial exposure time. If the initial exposure time is 10 milliseconds, the 
total acquisition time for this acquisition will be 10 milliseconds x 544 = 5440 milliseconds or 5.44 seconds. 

Initial Exposure Time for Super-OD Acquisition 
Whenever Super-OD is activated the acquisition interface disables the exposure time input fields and switches 
to Auto Exposure mode. The initial exposure time used for Super-OD is determined by a proprietary Auto 
Exposure algorithm. Clicking the Expose Preview button in Super-OD mode will calculate and display the 
initial exposure time. Clicking the Acquire button in Super-OD mode will start the Super-OD acquisition 
process which first determines the initial exposure value and then performs the Super-OD acquisition process 
automatically. 

Acquiring Super-OD Images 
Slide the Super-OD slider bar to the desired Super-OD factor. Click the Acquire button. When the process is 
complete the resultant Super-OD image will be displayed in the AlphaView software main window. 

Movie Mode

If kinetic, multiplex, color, or chemiluminescence experiments require the system to automatically capture 
several images at preset exposure times, preset time delay between images, preset lighting sources, or preset 
filter choices, then the AlphaView Movie Mode should be used. Movie Mode is accessible in the Camera 
Setup and Preview window. To launch the setup screen, click the Movie Mode button in the Camera Setup 
and Preview window. Movie Mode can also be accessed from Movie Mode in the ToolBox Enhancement 
Tools tab. 
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Figure 2-19: Movie Mode Setup

The Total Frames field sets the total number of individual frames in the movie. Each movie can capture 
maximum of 50 frames (images) and a minimum of one frame. 

The Frame field selects the active frame currently being used for condition customization. For example, if the 
movie uses three images, selecting Frame 1 allows for lighting and filter setup of the movie’s first frame; 
selecting Frame 2 allows for setup of the movie’s second frame. All frames can be adjusted manually using this 
technique, or specific lighting conditions can be copied to the next frame using the Copy To Next button. 
Copy To Next copies all settings from the previous frame to the current frame. The Copy to End button 
nscopies current frame setting to the entire frame set.

For chemiluminescence imaging, all lighting is typically shut off and the filter wheel is positioned for the nsche-
miluminescence position across all frames. In these situations, the exposure time is the only variable that 
changes from frame to frame. The Copy To Next button is a useful tool that optimizes setup time.

The Delay field configures a predetermined delay between captured imaged for kinetic experiments. The 
default Delay is set for the shortest possible delay (19 ms), but can be configured up to 50 minutes between 
images. 
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Once the movie setup is properly configured, click the Go button to begin the movie process. The system 
begins processing image acquisitions for each frame. When completed, the movie setup box disappears and 
the Toolbox window automatically configures to the Movie tools. This allows for movie playback, saving, load-
ing, or new movie recording.

The movie display buttons offer the following functionality:

Saving An Individual Image from a Movie
After you load, play, and stop a movie at the desired image, it is possible to save the individual image seen on 
the screen. Use the SAVE AS button located on the tool bar to save the image in the desired location and file 
format on the local or network drives. 

REC Launches the Camera Setup and Preview window configured to Movie Mode.

PLAY Displays the movie in a continuous loop.

STOP Stops the movie at the current frame display.

PAUSE Pauses movie playback at a user defined image.

REW (rewind) Rewinds the movie to the first image.

REV (reverse) Plays the movie in a continuous loop in reverse.

FWD (forward) Forwards the movie to the last image.

DEL (delete) Deletes the movie on the display.

NOTE: This function does not delete movies saved to the hard drive.

LOAD Loads a previously saved movie.

NOTE: This function does not load individual images previously captured in nor-
mal capture mode.

SAVE Saves a movie of images.
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Saving a Partially Acquired Movie
It is possible to stop the movie in the middle of acquiring frames, the user can exit the movie mode to save 
the acquired frames only.

Figure 2-20: Saving a Partially Acquired Movie

Option 1: Go to continue movie.

Option 2: Close Window to view and/or save acquired frames.

Save/Load Setup Acquisition
Individual movie parameters can be saved for future use. The Save Setup and Load Setup buttons save and 
load all Movie Mode setup parameters. This data is saved in files using the MVF format.

Figure 2-21: Movie Mode: Load/Save Setup
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Frame Stacking
The Movie Mode configuration of the Camera Setup and Preview window provides an option for stacking 
frames. If this selection is used during image acquisition, Stack Frames uses previous exposure information to 
sequentially add images to one another. Normal Sequence does not perform this addition. 

NOTE: Stacking frames increases the noise level in acquired images.   

Sample Case
Capture 5 frames at 1-5 sec exposure for total time exposure time of 15 sec

Display after summation of following frames:

Frame 1 = Image (1 sec exp time)

Frame 2 = Frame1 + Image (2 sec exp time)

Frame 3 = Frame2 + Image (3 sec exp time)

Frame 4 = Frame3 + Image (4 sec exp time)

Frame 5 = Frame4 + Image (5 sec exp time)

Automatic Image Capture (AIC) Software–Optional
For molecular biology researchers engaged in high throughput and particularly high volume work involving 
repetitive assays, Automatic Image Capture software is available as an option. This system automatically 
adjusts lens focus, filter settings (for fluorescent imaging), light settings and exposure for perfect images. All of 
this with just one click--making the acquisition of images faster and more convenient than standard imaging 
software. 

NOTE: AIC requires motorized zoom optics. 
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Designing a User Protocol

To utilize the single click feature of Automatic Image Capture, a protocol specific to your sample must 
be defined and saved. Click the Acquire button to reach the Camera Setup and Preview Window. 

 

All acquisition parameters that can be set by the user are available in the Camera Setup and Preview window 
and can be saved as a user protocol. Below is an example of the design of a protocol for imaging DNA gels 
stained with Ethidium Bromide. 

Figure 2-22:  Example of the Protocol Design for Imaging DNA Gels Stained with Ethidium Bromide

Next, click the Load/Save Protocol button to store your customized protocol. 

The Save/Load Acquisition Protocol dialog box appears, allowing to you save and name your protocol.
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Figure 2-23: Save/Load Acquisition Protocol

This dialog box is also useful for loading a previously saved protocol to make small modifications, or delete 
existing protocols. 

All settings and selections visible and accessed in the Camera Setup and Preview window are saved in this 
protocol. These settings include SuperOD, ZoomROI, lens settings (aperture, zoom and focus), exposure 
time (including auto exposure setup settings), sensitivity selection, display settings, cabinet lights and filter 
wheel position.

Auto Image Capture (AIC)

User-customized protocols can be recalled for single click image capture using the AlphaView software’s Auto 
Image Capture feature. First, load the protocol of interest by clicking on the drop down menu from the Auto 
Image Capture icon.

Figure 2-24: Auto Image Capture (AIC)

Then, once the protocol is selected, click the Auto Image Capture button to begin the acquisition process. 
Once the AIC process is initiated, a pop-up window, labeled Acquiring protocol, is displayed to indicate the 
status of the acquisition process. This progress window shows the current operation status and has some 
animations to indicate progress. The status messages towards the bottom of the window displays the specific 
operation and relevant parameters used during the process.
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The LIGHTS section displays different simulated LEDs repeating left to right to indicate the status of the light 
source and filter selection as dictated by the protocol. The CAMERA section displays the current status of the 
image as the target is being focused as dictated by the protocol. The ACQUISITION section displays the 
current status of the exposure time as dictated by the protocol.

Figure 2-25: AIC Status Window

NOTE: The images displayed in the Acquiring Protocol windows are animations to display status and do not 
reflect upon the image being acquired.
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AlphaView System Quick Guide

NOTE: This is intended as a quick reference guide for acquisition. For more detailed information on the 
individual features, refer to their respective feature sections.

1. Power on the system: 

a. Turn on the computer, monitor, and optional printer.

b. After the computer has finished loading the Windows desktop, turn on the power to the cabinet. 

c. The AlphaView software is activated by double clicking on the AlphaView icon.   

2. Positioning and focusing on the sample: 

a. In the Tool Bar, select the Acquire icon to activate the image acquisition software features. 

b. In the Camera Setup & Preview window, click the Focus button.

c. Open the door to the cabinet and position your sample on the preferred illumination source. 
Fluorescence samples that require epi or transillumination of UV energy should be placed on the 
purple UV filter glass. For colorimetric samples such as protein gels, films, or blots, use the fold-down 
white light table for your sample. For chemiluminescence use the fold-down white light table, or the 
adjustable tray if used in conjunction with the fast lens.

d. Open the aperture on the camera lens all the way open to the smallest number by either pressing the 
up and down arrow keys, entering in a value and pressing the tab key. or selecting the preset 
parameters from the drop-down menu.

e. With the door still open to allow light to enter into the cabinet, use the monitor’s real-time readout 
display to position and focus your sample in the middle of the preview image.

f. Focus on the object by either pressing the up and down arrow keys, entering in a value and pressing 
the tab key or selecting the preset parameters from the drop-down menu. For fluorescence and che-
miluminescence, the door to the cabinet can be used to adjust the amount of light that enters into 
the cabinet if there is too much light to obtain a good focus setting. Do not adjust the aperture to do 
this. For colorimetric samples, it is necessary to decrease the aperture to acquire the image.

NOTE: Business cards and other pieces of paper with small text often are the easiest objects to obtain 
optimal focus settings with. 

g. Adjust the zoom setting by either pressing the up and down arrow keys, entering in a value and 
pressing the tab key, or selecting the preset parameters from the drop-down menu so that the area of 
interest on the sample takes up the entire image size on the screen. 
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3. Capturing a bright sample like fluorescently labeled gels, colorimetric samples and film:

a. Close the cabinet door.

b. Choose the appropriate optical filter for your sample type:

Position #1 for colorimetric gels and film (no filter)

Position #2 for Ethidium Bromide gel sand some colorimetric gels

Positions #3-5 for other fluorescently labeled gels (optional filters)

c. Turn on the illumination source (UV or white light) using the touch panel or virtual software controls.

d. Select the green Expose Preview button.   

e. Check Show Saturation.

f. Check Auto Expose. 

g. Select the Normal/Ultra resolution setting. 

h. Once the image in expose preview does not contain any saturation (red false color palette for white 
bands, green for dark bands) click Acquire Image. The exposure bar will turn green when this is 
complete. If the exposure bar is pink in color, saturation is still present in the image. For extremely 
bright images, particularly in white light applications, it may be necessary to reduce the aperture 
setting until the saturation is removed from the image.

4. Capturing a low light image (like chemiluminescence)

a. Close the cabinet door (there should not be any lights on in the cabinet).

b. Choose Position #1 in the filter wheel for no filter.

c. Select the green Expose Preview button.   

d. Check Show Saturation.

e. Check Chemi Display.

f. Check Auto Expose.

g. Select the Super Speed resolution setting.

h. Wait for the exposure bar to indicate that the proper exposure time has been found and that there is 
no saturation in the image - the exposure bar will turn green when this is complete. If the exposure 
bar is pink in color, saturation is still present in the image. 

i. Select Medium/High or Normal/Ultra resolution and uncheck Auto Expose.

j. Click Acquire Image.



page 44 Chapter 2: Getting Started—Basic Imaging Functions

FluorChem HD2 and FC2 User Guide

NOTE: The exposure time will vary depending on which resolution setting is selected in step 4.h. If the 
exposure time calculated by the auto expose setting is too long, it is possible to use the Fast/Low or High/
Medium setting instead. Alternatively, if the exposure time is short enough, Normal/High may be selected 
for a full resolution (4 million pixels) chemiluminescent image. 

5. Save the original image:

a. Select Save Image in the File menu or click on the SAVE or SAVE AS icon in the Tool Bar.

b. Enter a file name and select the directory to which it should be saved (the directory path should be 
less than 100 characters).

c. Specify the file format (TIF, BMP, PCX, MAC, color TGA).

d. Click OK to save the file.

6. Enhance the display (optional):

a. Adjust the black, white and gamma levels by moving the slider bars at the right of the image in the 
Contrast Adjust window, or select Auto Contrast.

b. Apply the digital filters found in the Tool Box under the Enhancement and Filters (to stop a filter, hit 
any key on the keyboard; to reverse the effects of a filter, click Undo).

c. Add text, boxes, arrows, etc. to the image using the annotation tools in the Tool Box under Enhance-
ment and Annotate.

7. Print the image using the PRINT button in the Tool Bar or the pull-down File menu option.

8. Analyze the sample using the analysis features in Tool Box (ANALYSIS for quantitative analysis).

Contrast Adjustments
The Contrast Adjustments window allows for the best visualization possible of a sample utilizing the black, 
white, and gamma adjustments, as well as, image reverse and auto contrast. 

The image on the screen is made up of picture elements (pixels) in an array. Each pixel is assigned a brightness 
(or a gray scale value) level between black and white. A very bright image has most of its pixels registering 
high gray level values and conversely, a very dark image has most pixels registering low gray level values 
(approaching zero).

The distribution of these gray values to the image is determined by the Contrast Adjustment controls. These 
controls regulate the Black level, White level, and Gamma setting (brightness linearity), allowing adjustment of 
the display to obtain the best image possible. 
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NOTE: These enhancement features modify the image display on the monitor only, and do not change the 
original quantitative data.

AlphaView software can also import RGB color images. The AlphaView Software automatically detects this 
process and the Contrast Adjustment tools are configured for color image adjustments.

NOTE: An image can be enhanced using these tools and then saved as a modified file for publications. 
However, to preserve the original image information, it is recommended that the file be saved as a 
different file name when using the save modified.

Using the Contrast Adjustments Tools for Grayscale Images

There are three sliding scales found in the image control area to the right of the image. Below each scale is a 
box displaying a number that corresponds to the position of the slider. By adjusting these sliding scales, the 
image display can be optimized.

Figure 2-26: Contrast Adjustments Settings

Figure 2-26 displays the imaging display tools: Black level, White level, Gamma setting with B/W/G, Linear, Log, 
and Equalize options.

To adjust any of these settings, place the cursor on the slider. Click and hold down the left mouse button 
while dragging the slider to a new setting. As the slider is moved along the scale, the image display is updated, 
along with the change in numeric value. The arrows above and below the scale bars can also be clicked to 
change the settings in single unit increments, or, the user may type in a specific unit.
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Black Level Adjustment 

The number beneath the Black Level scale corresponds to a gray level. There can be 256, 4095, or 65,536 
possible gray levels depending on the system type. For the example below, an 8 bit image will be used with 
256 total gray scale values. When the Black slider is at the very top of the scale, the number is 0. As the slider 
is moved downwards along the scale, the number increases and the image becomes progressively darker. This 
is because all pixels at the specified gray level and lower are shown on the screen as black pixels. If the slider is 
set to 0, all the pixels whose gray levels are at 0 are shown as black. If the setting is then changed to 60, all the 
pixels between 0 and 60 are shown as black and the image appears darker.

Figure 2-27: Black Level Adjustment Example

White Level Adjustment

The number beneath the White Level scale also corresponds to a gray scale value. When the slider is at the 
very bottom of the scale, this number is 255. As the slider is moved upwards along the scale, the number 
decreases and the image becomes progressively lighter. This is because all pixels at the specified gray level 
value and above are shown on the screen as white pixels. For example, if the slider is set to 150, all the pixels 
between 150 and 255 are shown as white and the image appears lighter.   

Figure 2-28: White Level Adjustment Example
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Gamma Setting Adjustment

Changing the Gamma setting affects the image brightness by adjusting the linearity of the image on the screen 
and printouts, but does not affect quantitative data. 

The camera sees objects linearly while the human eye does not. When the Gamma setting is set to a value of 
1, the image is displayed as the camera sees it. This, however, is different from what the human eye detects. By 
adjusting the Gamma setting, the user can make the image on the screen correspond to what is seen when 
he/she looks directly at the object. We recommend a Gamma setting of 0.55 for best visual representation.

Figure 2-29: Gamma Setting Adjustment Example

The Auto Contrast Selection

The Auto Contrast feature will automatically scale the black and white values of an image to more tightly fit 
the gray scale intensity profiles (histogram). This selection will use different black and white values for different 
images depending upon their unique histograms. A more dramatic visual change will take place for low light 
level images (such as chemiluminescence) where smaller portions of the histogram are used. This selection 
can be turned on or off and will adjust differently for each image. 

The Reverse Button

The Reverse button inverts the gray levels of the displayed image, converting a positive image to negative, or 
vice versa. For instance, an image with black bands on a white background is converted into an image with 
white bands on a black background by simply clicking the Reverse button. Clicking the button a second time 
returns the image to its original form.
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Figure 2-30: Original Image vs. Reversed Image

NOTE: Reversing an image changes the way it is displayed on the screen, but does not change the 
quantitative data. For example, the bands in the above gel have the same density, regardless of whether 
the gel is displayed as white bands on a black background or black bands on a light background. For 
information on reversing pixel values, see Chapter 5, “Image Analysis Tools“.

The Equal Button 

The Equal button flattens the image to show all pixel values in the original image. Equal automatically adjusts 
the image display for maximum contrast which is beneficial for faint band detection.

Figure 2-31: Original and Equal Image

Making Linear, Log, or Equal Adjustments

Figure 2-32 shows an original image of film using default BWG settings. 



Contrast Adjustments page 49

FluorChem HD2 and FC2 User Guide

Figure 2-32: Original Image of Film with Default BWG Settings

Figure 2-33 shows the image of film with linear Contrast Adjustments selected. The Linear tab provides mini-
mum and maximum adjustment tools from 0 to 100%. Linear stretches the grayscale range of the displayed 
image to the system dynamic range of 0-65,535 grayscales.

Figure 2-33: Contrast Adjustments—Linear Tab Settings

Figure 2-34 shows the image of film with log the Contrast Adjustments selected the log provides minimum 
and maximum adjustment tools from 0 to 100%. The Log performs a logarithmic adjustment to the grayscale 
range of the displayed image.
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Figure 2-34:  Contrast Adjustments—Log Tab

Figure 2-35 shows the image of film with equal Contrast Adjustments selected. The Equal option automati-
cally adjusts the image display for maximum contrast which is beneficial for faint band detection. 

Figure 2-35: Contrast Adjustments—Log Tab
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Automatic Enhancement

Figure 2-36: Automatic Enhance Levels

This function is ideal for new or inexperienced users of the system since it offers 9 levels of automatic image 
enhancement of the black, white, and gamma levels simultaneously. For an inexperienced user, in can be 
difficult to adjust each black, white, and gamma buttons to their respective optimal positions. By clicking on 
one of the nine Auto Enhance Level buttons, the image is optimized according to a unique level. Button 1 will 
make the image ‘darker’. Each increasing button click will ‘lighten’ up the image until button 9 is pressed which 
will make the image the ‘lightest’ possible.

To undo any Auto Enhance Levels, just press on the Reset button on the main interface.

Figure 2-37: Image Levels and Enhance Tool Examples

Imaging Tools

Tool Bar

The Tool Bar window provides intuitive icons for the most common functions in AlphaView.
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Figure 2-38: AlphaView Tool Bar

Icon Description

The Navigator icon starts the AlphaNavigator wizard.

The Open icon functions identically to the File Open function in the upper menu bar. This 
function is used to open previously saved images. Detailed instructions are available in Chapter 
3, “Drop-Down Menus“.

The Save and Save All icons function identically to the File > Save and File > Save All functions 
in the upper menu bar. This function is used to save captured images to the desired storage 
medium.

Once an image is displayed, it can be printed on the default printer by clicking the Print icon in 
the Tool Bar window display. Most printers can be configured through the Windows operating 
system to be the default printer. Refer to your Windows operating manual for more informa-
tion on installing a default printer.

The Zoom Out and Zoom In icons provide easy zooming ability while you are active in image 
enhancement or analysis functions providing increased versatility. Detailed instructions are avail-
able in Chapter 4, “Image Enhancement Tools“ as this function is also available in the Tool Box, 
Enhancement Tools. 

Assists the user to zoom in on a selected area, the average pixel is displayed.

The Fit in Screen icon adjusts zoom factor to fit image in available screen area.

The Image Drag icon is useful for to pan with a zoomed image. To activate this function, click 
the icon and move the mouse cursor to the image. The cursor will have changed to a small 
hand. Click the left mouse button and drag to move the image. When you are done, you can 
click the Image Drag icon again to deactivate it. 

NOTE: Image Drag is only active when the image is zoomed in beyond 1X (greater than 
100%). The icon is grayed out in other zoom modes.
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Compare View

Two or more images can be opened in compare view. To open compare view, click on the Compare 
View icon.

If only two images are opened in the tab view, images will directly open in compare view. If more than two 
images are opened in tab view then a dialog box pops up, through which image can be selected to open in 
compare view.

The Saturation icon allows for a quick image display of saturation. Completely saturation black 
regions (gray scale 0) will turn green and saturated white regions (i.e. gray scale 255, 4095, 
65,535) will turn red. This is a useful tool to check for linearity of an image before analysis 
occurs. Saturation is a feature that is most important during the acquisition stages and is 
thoroughly detailed in the acquisition features of the system manuals.

The Image Overlay icon creates an RGB image from three grayscale images. Select the images 
for the Red, Green and Blue channels in the selection window

Clicking Reset returns the image to the system defaults as specified in the active default file. 
This is detailed later in Chapter 3, “Drop-Down Menus“.

Clear removes any overlays currently displayed on the image. This function can be useful if 
annotations or other displays obscure parts of the image.

Saves the analysis.

Loads an analysis.

The Notepad icon opens up a dialog box to allow the user to quickly track experimental 
conditions, comments, and any other details to be saved as an electronic copy for future 
reference. Detailed instructions are available in Chapter 3, “Drop-Down Menus“ as this Notepad 
function is duplicated in the Utilities function in the upper header bar.

The Open File Explorer opens windows file browser

The Compare Image icon allows comparing two or more images in compare view.

Icon Description
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Figure 2-39: Selecting Images in Compare View

If two images of same size are opened in compare view then synchronize checkbox, in status bar, will be 
available to use. By activating synchronize function scroll and zoom can be applied on both images together.

To switch back from compare view to tab view simply clicks on the Compare View icon.

Figure 2-40: Switching Back from the Compare View

Another way is by drag one image tab to see the docking options as shown in Figure 2-41.
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Figure 2-41: How to Enter the Compare View

After selecting appropriate place, when you drop the image tab, Compare view will be opened.

Figure 2-42: Compare View Result
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Tool Box

The Tool Box window contains an intuitive interface for performing all image enhancement and analysis 
functions. 

Figure 2-43: Tool Box

The Enhancement Tools option contains the controls for enhancing and adjusting the image. This includes 
software filtering, false colors, zoom factors, and other unique features. The Analysis Tools contain the 
controls for quantitative analysis including gel smiling corrections, band matching, Lane Profile densitometry, 
multiplex band analysis, molecular weight calculations, colony counting, and arrays. Both the Enhancement 
Tools and the Analysis Tools are detailed in Chapter 4, “Image Enhancement Tools“ and Chapter 5, “Image 
Analysis Tools“, respectively.

Status Bar

The Status Bar is located on the bottom of the monitor and provides a real time display of the mouse cursor 
x, y position, the image zoom factor, and the grayscale intensity at the mouse cursor x, y position.

Figure 2-44: Status Bar
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Chapter 3:

Drop-Down Menus

Chapter Overview
• Main Menu

• File Menu

• Edit Menu

• Image Menu

• Setup Menu

• Overlay Menu

• Utilities Menu

• View Menu

• Window Menu

• Help Menu
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Main Menu
Across the top of the screen is a Windows menu bar containing several system operation functions. These 
include file saving and loading, edit, image, setup, overlay, file utilities, view, window and help functions. 

Figure 3-1: AlphaView Drop-Down Menu Bar

File Menu
Use this menu to save an image as a file, retrieve a previously saved image, select different printers, print an 
image to a parallel printer, overlay multiple images in RGB color channels, close an image, log-off of the system 
or exit the system. 

Figure 3-2: File Pull-Down Menu

File > Open Menu

This function opens an image, which has been previously saved as a TIF, GLP, BMP, PCX, TGA, PIC, JPG, PNG, 
FCZ or Macintosh® TIFF (MAC) file. 
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Figure 3-3: File > Open Dialog Box

Using the left mouse button, click on the name of the file to be loaded. That name is then highlighted in the 
list and appears in the text box below the File name prompt. 

Alternate disk drives can be accessed using the “Look In” dialog box.

Once the file has been selected, click on the Open button to load the file. (Alternatively, double-click on the 
file name.) The dialog box disappears and the selected image appears in the image window on the screen.

To dismiss the dialog box without loading an image, click on the Cancel button.

File > Save/Load Analysis

You can use Save/Load analysis feature from file drop-down menu, to save all your work and then load it back 
for later use.

NOTE: The load analysis menu item can only be accessed when the user opens any the analysis tools. If 
the image opened has an analysis saved, the item will be activated.
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Figure 3-4: Save/Load Analysis Feature

File > Close Menu

This function closes the image currently displayed on the screen.

File Save, Save As, Save Modified, and Save All Menus

Save allows original images to be saved in several different formats. Save As allows images that have 
previously been saved to be saved in a different location or as a different file type without affecting the original 
image. Save Modified saves the image as a 8-bit color image with annotations burned into the image. Save 
All saves all images in .tiff format only.

AlphaView has the ability to save files in several formats; see Figure 3-5.

Figure 3-5: File > Save As Dialog Box
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Enter a new file name in the text box adjacent to the File Name prompt. Next, choose a file type from the 
Save As type list. 

AlphaView will automatically give the appropriate 3-character extension. AlphaView will also create a file with 
the same base name and a .STP extension. This setup file saves information specific to this file, such as Black 
Level, White Level, Gamma Setting and 1D-Multi template placement. If the file is accessed later, these set-
tings will be recalled.

File Types
TIFF is the default file format for AlphaView files. TIFF is an acronym for “tagged image file format” and was 
developed as a flexible and machine-independent graphic file format. Saving as a TIFF file will allow users to 
double-click TIFF files from Windows Explorer and automatically launch the application on any machine that 
has AlphaView loaded on it. Please refer to “Preferences” on page 72 for information on how to customize 
the default file type. 

Mac TIFF is the Apple Macintosh version of the TIFF file format. Mac TIFF files have the extension .MAC so 
they can be easily distinguished from Windows TIFF files. Most software can distinguish between Mac and 
Windows TIFF formats and can accept either. AlphaView offers the option of both formats in the event that 
only one of the two is acceptable.

GLP is a proprietary file format that allows changes to only be made in AlphaView programs. It will accept 8-
bit and 16-bit images and cannot be opened in any other software program. 

BMP, PCX, TGA, PIC, JPG, GLP are additional graphic file formats which may be useful when saving an image 
for desktop publishing. These file formats can be imported directly into many Macintosh! and PC programs. 
(For more information, see Appendix A, “Opening AlphaView Files in Other Software Programs“.) 

NOTE: Do not use these formats to save images that will be analyzed later, since pixel data can be lost or 
altered when saving files in these formats. 

NOTE: Not all of the file types listed above can be saved as a 16 bit file. The AlphaView software allows 8 
bit Tiff images to be saved as BMP, JPG, or Tiff format. 16 bit Tiff images can only be saved as Tiff images. 
Some may require you to convert the image to an 8 bit file first. 
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Original versus Modified Files

An Original image file is one in which the data is saved in an unaltered form. This option should be selected if 
the image will be analyzed later. If the Black level, White level, or Gamma settings have been adjusted, the new 
values are saved but the pixel values are not altered. When this file is opened at a later time, AlphaView will 
display it with the values that were displayed when the image was saved, however, it is still possible to revert 
to the original raw image file by selecting Reset on the Tool Bar.

Annotation information cannot be saved with the Original image option. It can, however, be saved as an 
Overlay. Please refer to “Overlay” on page 66 for more information. 

If the image was saved as an original file using an older system, some distortion may occur when viewing it in 
desktop publishing or word processing programs. If this occurs, save a copy of the image in the modified for-
mat before importing it into another software package. 

An image that is saved as a modified file permanently retains the changes to the image’s Black level, White 
level, and Gamma setting. Annotations and any filtering performed are also saved with the image, replacing 
original image information with the new information. 

NOTE: If the image is saved as a Modified file it is converted to an 8-bit image. 

Print

This function sends the image to the default printer specified in Print Setup.

Printer Setup

This function displays a dialog box in which the settings for the parallel printer are specified. When all the 
pertinent printing preferences have been specified, click on the OK button. If you purchased a printer with 
AlphaView, this will be preset from the factory.
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Figure 3-6: Page Setup Dialog Box

Figure 3-7: Page Setup—Printer Dialog Box

For more information on using the Print menu, see the Windows manual.

Exit Function

The Exit function closes AlphaView. To restart AlphaView from Windows, double-click on the AlphaView 
icon.
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Edit Menu
The Edit menu provides the ability to copy, crop, reset and remove any annotations or filters that have been 
added to the original image. 

Figure 3-8: Edit Pull-Down Menu

Edit Activation

To activate the Copy and Crop functionality, place a check mark next to Edit Activation. This will turn the 
mouse cursor into a + sign that will allow you to highlight the region of interest for the image. After Edit 
Activation is highlighted, the desired area of interest is drawn using the mouse. 

Figure 3-9: Ready to Crop or Copy
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Once this is completed, you can select either the Copy or Crop function in the Edit menu options.

Copy and Crop

Copy will copy the desired area of interest into the Windows Clipboard and allow you to paste into any 
desktop publishing package (i.e. Word, Excel, Adobe Photoshop, etc.). 

Crop will display just the region of interest as the active window in the AlphaView interface.

Figure 3-10: AlphaView Interface—Sample Crop 1

Reset and Clear Options

The Reset option configures the Black, White, and Gamma settings to default settings. The Clear option 
removes any annotations that are present on the image.

Image Menu
The Image menu provides the ability to perform a variety of image processing functions.
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Figure 3-11: Image Pull-Down Menu

Overlay

To superimpose images, use the Overlay function under the Image File menu. This function will display 
separate multiplexed images or a RGB color image as a compiled image with the appropriate color channel 
images added together. A simple way to acquire multiple images for this function is to use the Movie Mode 
function in image acquisition and acquire a series of identical images.

The Overlay Images option allows you to overlay up to three different images with three different color 
channels. You can select the Browse button for each color channel and select the appropriate images to be 
used for generating a color image. For example, if you have a saved grayscale images of an identical gel taken 
with a SYPRO red filter for the red stain and a SYBR green filter for the green stain, you can choose these 
images in the appropriate Red and Green Channels to generate a composite image with the red and green 
colors mapped onto the compiled image. 

NOTE: The images must be the same bit depth and resolution for the software to overlay the images.

Equalize

The equalize option performs a duplicate function to the Equal option in the Contrast Adjustment Window. 
This is a useful function for detecting faint bands on a sample.

Arithmetic

The Arithmetic function is used to add, subtract, average and divide several images together to generate a 
compiled image. 
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Figure 3-12: Image > Arithmetic Menu

To average a set of images together open one of the images in the set and then select ‘Average a Set…’ under 
the Image pull-down menu. A prompt will appear allowing the user to select all of the images that for the set. 
It is possible to browse the directories looking on the network drives and removable media if necessary. Once 
all of the images have been selected click on the open button to finish the image set. The resulting image is an 
average of all of the images together. This is a useful function for extending the dynamic range on a set of sim-
ilar images by allowing bright spots and faint spots to be seen on the same image. 

The other functions are adding, subtracting and dividing images together. Adding together images is frequently 
used for colorimetric markers run together with chemiluminescent samples. Subtracting images is often used 
to remove noise from a sample by running dark images first and subtracting them out of the final image.   The 
most common application for quotient is for those technical users who run their own flat field corrections. 
This can be done using the Flat Field Calibrate selection under the Image pull down menu which will be 
described in detail later in this section. 

All three of these arithmetic functions are performed by opening the main image that will be adjusted. Next 
select the appropriate arithmetic function under the image pull down menu. Then select the image that is to 
be added, subtracted or divided from the original image and select open. The dialog box will disappear and 
the resultant image will appear.

NOTE: Images that have been arithmetically altered are ideal for publications and documentation, how-
ever, they are strongly not recommended for analysis as the pixel values have been adjusted. 

Conversion

Because AlphaView can generate 16-bit files, the conversion option is useful when an image is to be imported 
into a program that only accepts 8-bit images. Choosing this option will convert a 16-bit image into an 8-bit 
image.
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A 48-bit color image can be converted into a 16 bit grayscale image by simply averaging the RGB values for 
each pixel.

Figure 3-13: Image > Conversion Menu

Flat Field Calibrate (Manual)

Flat Field Calibrate is a function that is used to ‘flatten’ the image so that the pixel data is even across the 
entire image area. This is a function that is useful for large gels and other applications that use the entire field 
of view for an image.

Creating flats can be art in itself; there are many documents on the internet that can help users interested in 
this arena to create the ideal flat for the application. However, some useful flats that have been created in the 
past involve very simple tools like a piece of 8.5 x 11 regular low quality copy paper (higher quality paper 
contains watermarks that will show up in the final image). It is essential that both the flat and the gel images be 
identical, including the aperture, zoom (if applicable) and focus settings on the lens. 

Step-by-Step Manual Flat Field Calibration applied to an existing image:

1. Place the gel or other application in the cabinet or dark room.

2. Adjust the aperture, zoom (if applicable) and focus on the lens.

3. Use auto-expose set to the normal selection and acquire an image of the gel. (Alternatively, it is possible 
to select show saturation and then use expose preview and adjust the exposure time manually to just 
under saturation.)

4. Save the image of the gel.

5. Next remove the gel from the UV transilluminator or white light tray and clean and/or dry off the surface 
if necessary using glass cleaner.

6. Place the white piece of paper onto the appropriate surface. (For example, if the UV transilluminator was 
used, place the paper onto the UV transilluminator; if the white light tray was used, place the piece of 
paper onto the white light tray.)

7. Turn on the appropriate light source used (white light, UV transilluminator, epi lights, etc.).
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8. Without changing anything on the lens acquire another image of the ‘Flat’ image following step 3 again. 

9. Save the Flat image.

10. Open the original gel or other application image.

11. Select Flat Field Calibrate from the Image pull down menu.

12. Browse the directories for the ‘Flat’ image created.

13. Click on open. Make sure to save the flat field calibrated image for future use.

Resize

The Resize function is to resize an image to a specific dimension for use in graphical presentations. You have 
the option to ‘Preserve aspect ratio’ to avoid image dimensional distortion, or you can deactivate this function 
and configure the image resolution to the desired width and height dimensions. 

Figure 3-14: Resize Image Dialog Box

NOTE: It is recommended that you DO NOT perform quantitative analysis on resized images.

Image Information

The Image Information function provides a dialog box with all detailed image properties. To remove this 
dialog box from the screen, click OK.



page 70 Chapter 3: Drop-Down Menus

FluorChem HD2 and FC2 User Guide

Figure 3-15: Image Information Dialog Box

Setup Menu
This menu customizes the system settings by allowing users to save default parameter preferences and 
customize the software settings. 

Figure 3-16: Setup Pull-Down Menu
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Print Info

Figure 3-17: Setup > Print Info Menu

When printing an image, basic image information is included on the print. This includes the exposure time, 
the Black level, White level, and Gamma setting, the date and time the image file was generated, an image ID 
number, and the name of the file to which the image is stored. 

To print this information at the top of the print, choose Top from this menu. To print at the bottom of the 
print, choose Bottom. 

NOTE: Printing image information at the top or bottom of a print may obscure a small portion of the 
image. To print the image with no information on it, choose Off.

Print Mode

AlphaView software provides custom printing options. 

Figure 3-18: Setup > Print Mode Menu

Printing can be achieved in three different methods:

• Full Image—Prints the original image. Does not print zoomed images or images overlaid with data 
screens.
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• Screen Dump—Prints the imaging area. Well suited for printing images overlaid with data screens and/
or graphs, zoomed images, etc.

• Image Window—Prints the highlighted window.

Print Date

Under the Setup menu there is a selection labeled “Print Info”. This allows the user to change the format in 
which the date is printed. The choices are MM/DD/YYYY and DD/MM/YYYY.

Preferences

In order to change the preferences of the system, you will need to find the administrator of the AlphaView 
software program to log in; the login is enforced only on data altering tool tabs (image acquire, cabinet 
settings, and auto enhancement).

Figure 3-19: User Login Dialog Box

There are five tabs in the Preferences menu (the AlphaView Stand Alone software does not contain the 
Image Acquire or Cabinet Settings tabs):

• General—Configures prompts and file saving/opening formats.
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Figure 3-20: Preferences—General Tab

• Image Acquire—Inverts the image seen by the camera and adjusts the ROI values.

Figure 3-21: Preferences—Image Acquire Tab
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NOTE: Cell Biosciences does not recommend that you make any changes to these settings without contact-
ing technical support first. Some features on this tab are not currently implemented in the software.

• Cabinet Settings—Used for adjusting the port settings and customizing filter positions on the cabinet.

Figure 3-22: Preferences—Cabinet Settings Tab

• Auto Enhancements—Used to customize the Auto Enhance Levels located in the Image Enhancement 
tool box.
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Figure 3-23: Preferences—Auto Enhancement Tab

To make changes to the preferences, select your change by typing in a new value or select/de-select the 
appropriate box with a check mark and then select apply. Some settings may require that the software be re-
started for the change to take effect.

• Analysis Tools—Used to show/hide additional image analysis tools. Any change in the settings will 
require software be re-started for the change to take effect.

Figure 3-24: Preferences—Analysis Tools Tab



page 76 Chapter 3: Drop-Down Menus

FluorChem HD2 and FC2 User Guide

System Calibration

In order to use system calibration, it will be required the administrator log in of the AlphaView software 
program.

Figure 3-25: Setup—System Calibration Menu

Darkmaster Utility—See Appendix D, “Bias and Dark Master Utility“.

Flat Field Calibration (Auto)—See Appendix E, “Flat Field Calibration“.

Overlay Menu
The Overlay menu provides a means of saving and retrieving annotation overlays. This is especially useful 
when a standard gel format is run repeatedly. Lane numbers, molecular weight marker sizes, and other 
pertinent information can be stored as an Overlay file and retrieved at a later date. This eliminates the need 
to re-enter the information each time a new image is captured. 

Figure 3-26: Overlay Pull-Down Menu

An overlay is any set of annotations (text, boxes, arrows, etc.) that have been drawn on the image. They can 
be saved as a group and opened later.   If repetitive samples are being imaged, an overlay eliminates the need 
to re-enter the same information (such as lane numbers, standard sizes, etc.) continually.
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Load Overlay

The Load Overlay function allows Overlay files to be retrieved and applied to the image currently displayed. 

Opening an Overlay after an image has been captured places the annotations on top of the image. They can 
be stored as part of the image by saving the file as a modified file. Please refer to “File Save, Save As, Save 
Modified, and Save All Menus” on page 60 for more information.

Select the name of the file to be loaded. (If necessary, change the directory or drive.) The file name is then 
highlighted in the list and appears in the text box below the Filename prompt.

Once the file has been selected, click on the OK button to load the file. (Alternatively, double-click on the file 
name.) The dialog box disappears and the annotations in the selected file appear on the image.

To dismiss the dialog box without loading annotations, click on the CANCEL button.

Save Overlay

Once annotations have been made, select Overlay > Save Overlay.

Figure 3-27: Save Overlay File Selection Dialog Box

Enter a new file name in the text box below the File Name prompt. AlphaView will automatically give the 
appropriate 3-character extension.
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The current directory is the one in which the new overlay file will be saved. If necessary, change the directory 
or drive as described in Section 3.1.

Once a name has been entered and the appropriate directory has been accessed, click the SAVE button to 
save the overlay file.

Overlay Libraries

AlphaView contains a library of overlays that can be accessed through the Load Overlay function described 
above. This library of overlays is stored in the Image folder located in the AlphaView directory:

The objects in these overlays can be repositioned, resized, re-colored, copied or deleted as needed.

Show Annotation

To displays or hides annotations in Analysis modules.

Utilities Menu
A number of functions are now handled by Windows programs. To access many of these programs while in 
AlphaView, open the Utilities menu and select the program of choice.

Figure 3-28: Utilities Pull-Down Menu

08WHITE.OVR / 08BLACK.OVR 8 lane labels in white/black

10WHITE.OVR / 10BLACK.OVR 10 lane labels in white/black

12WHITE.OVR / 12BLACK.OVR 12 lane labels in white/black

15WHITE.OVR / 15BLACK.OVR 15 lane labels in white/black

24WHITE.OVR / 24BLACK.OVR 24 lane labels in white/black

HINDIII.OVR #HindIII label
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Notepad 

The Notepad is a blank screen that allows the user to make notes about the experiment and save them as an 
ASCII file. The Notepad is useful for saving any imaging comments or experimental conditions with the saved 
image for future reference.

Figure 3-29: Notepad Display Window

Explorer

Windows Explorer allows access to files and other information saved on the local machine or the network, if 
applicable. 
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Figure 3-30: Windows Explorer Window

View Menu
The View menu provides the ability to control the display of the on-screen control tools as well as provide 
image enhancement abilities.

Figure 3-31: View Pull-Down Menu
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Default Tools Position

Four (4) main control windows exist within AlphaView: Tool Bar, Contrast Adjustment, Tool Box, and Status 
Bar :

Figure 3-32: Tool Bar

Figure 3-33: Contrast Adjustments Window

Figure 3-34: ToolBox Window

Figure 3-35: Status Bar
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These control windows automatically open when AlphaView is launched for additional ease of use and to 
generate a common ‘look and feel’. Since these items are ‘floating’ tools, you can click on Default Tools 
Position to move all tools to the default locations for more intuitive operation. Lastly, except for the status bar, 
it is possible to select and move any of the other windows to a custom location. 

Zoom Functions

Additional options provide the ability to Zoom In and Zoom Out on the image, Zoom to 1X and to Fit to 
Screen. 

NOTE: Zoom In and Zoom Out are duplicate functions for the Zoom In and Zoom Out icons in the 
ToolBar and the Zoom options in the Enhancement Tools.

Window Menu
The Window menu provides the ability to navigate from one image window to next image window. It also 
allows user to close all documents.

Figure 3-36: Window Pull-Down Menu
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Help Menu

Figure 3-37: Help Pull-Down Menu

Complete instructions on how to use the software along with detailed explanations of all features are avail-
able from the AlphaView Help option of the Help menu. 

To display system information, select the About option in the Help menu. This button accesses a pop-up box 
(see Figure 3-38), which shows the system serial number and software version number. Use this information 
when contacting Cell Biosciences for technical support, software upgrades, etc.

Figure 3-38: AlphaView—About Help Display

To close the box, click on the OK button.
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Chapter 4:

Image Enhancement Tools

Chapter Overview
• Tool Box Enhancement Tab

• Zoom

• Histogram

• Rotate-Flip

• Annotate

• False Color

• Filter

• Movie Mode
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Tool Box Enhancement Tab
Image enhancement tools are contained within the Tool Box as indicated. This tool set allows the user to 
zoom the image, rotate-flip the image, show the image histogram, perform automatic image enhancement, 
annotate on the image, display false colors, apply software filters, and activate the Movie function. 

NOTE: Many image enhancement tools do not function with multichannel images.

Figure 4-1: Tool Box

Zoom

Figure 4-2: Zoom Tool

The Zoom tool function magnifies an image, making details easier to see, and allows movement around the 
magnified image.
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An image can be displayed ¼x, ½x, 1x, 2x, 4x, or 8x larger than the original display by clicking on the 
appropriate buttons. To return to the original magnification, click on the 1X button.

When an image is magnified, only part of it can be displayed on the screen at any one time. To see different 
parts of the magnified image, use the green Pan Control box. The outer box shows a thumbnail of the entire 
image while the inner green box represents the portion currently displayed on the screen. 

To view different regions of a magnified image, move the cursor into the inner box. Click and hold down the 
left mouse button. The cursor changes to a hand; use it to drag the green box until the desired region of the 
image appears on the screen.

Alternatively, use the scroll bars in the image window to move the image up or down, and left or right.

On-screen Zoom tools are also available located on the main Tool Bar. This function duplicates the Zoom 
tool in Tool Box, and also allows for Image Drag to easily pan the image during any analysis functions located 
in “Zoom” on page 86 (in the Analysis Tools option).

Image Drag icon in ToolBar

Zoom Icons in ToolBar

Histogram
The histogram is a graphical display of the proportion of pixels assigned to each of the 4,095 gray levels.

Figure 4-3: Histogram Display in the Tool Box

The image is made up of picture elements (pixels) having brightness levels ranging from black to white. A very 
bright image will have most of its pixels registering high gray levels and conversely, a very dark image will have 
most pixels with low gray levels (approaching zero).
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The histogram is displayed in the lower left corner of the screen, below the image window. The horizontal 
axis represents the gray scale range: black at the left end and white at the right end, with levels of gray in 
between. The number of pixels registering a particular gray level determines the height of each bar along the 
axis.

A Coomassie blue-stained protein gel visualized with a white light box has a histogram reflecting mostly bright 
pixels: 

Figure 4-4: Histogram of a Typical Coomassie Gel

Most of the pixels are found in the light portion of this histogram. The dark bands represent a small number 
of pixels and include a variety of gray values, and therefore do not show up as a single peak.

The histogram function is particularly useful to verify that an image spans the maximum range of gray levels. 
When an image is to be used for analysis, it is especially important that the gray level range be as large as 
possible. If an image does not include most of the gray levels, we recommend repeating the image capturing 
process.
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Rotate-Flip

Figure 4-5: The Rotate-Flip Tool

The Rotate-Flip tool function rotates the image in a clockwise or counterclockwise direction by 1$ increments 
up to a maximum of 90$ in either direction. This is a useful tool if the image is not aligned properly during the 
capturing process. 

To rotate an image, click and hold down on the center sliding bar with the left mouse button and move it left 
or right until the desired angle of rotation appears in the rotate box. Release the left mouse button and image 
will rotate to the desired angle. To undo a rotation, just click on the Undo button. Also, a Flip option allows 
for the image to be rotated 180$ in a vertical or horizontal fashion.

The Reset button on the main software interface will also remove any rotations or image flips and return to 
the display to the original image.

Figure 4-6: Rotate-Flip Tool Images
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Figure 4-7: Rotate-Flip Tool Controls

Annotate
The annotation tools, include a number of different options for adding text (including Greek symbols), draw-
ing arrows and otherwise marking an image. 

NOTE: These tools are for annotation only. For information on drawing objects for quantitation purposes, 
see Chapter 5, “Image Analysis Tools“.
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Figure 4-8: Annotate Toolbox

Object Attributes

Use the COLOR, PEN WIDTH, PEN STYLE, LINE ENDS, TEXT STYLE and/or TEXT ORIENT menus to 
specify object attributes. Attributes can be assigned to the cursor before drawing or typing. Alternatively, they 
can be assigned to an object while it is in “edit” mode (see the following subsections for more details).

Annotation Colors

Annotations can be displayed in a variety of colors. The color options are displayed by clicking the COLOR 
radio button. To select a color, simply click the cursor on the button labeled with the desired color. The color 
button appears depressed, indicating that it is selected. Any annotations subsequently entered will appear in 
that color. It should be noted, however, that annotations are printed in gray scale on the video printer. Further, 
when an image is saved as a modified image, the annotations are saved in gray-scale, not color.

Line Thickness

The PEN WIDTH option specifies the thickness of lines when using the freehand, lines, box and circle drawing 
tools. Click on the appropriate checkbox for the desired width. All annotations subsequently entered will 
appear at that width.
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Figure 4-9: Pen Width Selection Tools

Line Types

The PEN STYLE option specifies the style of lines when using the freehand, lines, box and circle drawing tools. 
Click on the appropriate checkbox for the desired style. All annotations subsequently entered will appear in 
that style. 

NOTE: These pen styles only work with a thin line (see the “Line Thickness” section).

Figure 4-10: Pen Style Selection Tools
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Arrows and Straight Lines

The LINE ENDS option specifies the style of the ends of straight lines (no arrow, single arrow or double 
arrow). Click on the appropriate checkbox for the desired style. 

NOTE: These line ends work with any line thickness.

Figure 4-11: Line Ends Selection Tools

Text Background and Font

The TEXT STYLE option specifies the style of text. Click on the appropriate checkbox to show text with or 
without a background. An opaque background is useful if annotations will be made on an image that has wide 
variations in gray scale. By using an opaque background, text will not be “lost” in the background of the image.
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Figure 4-12: Text Style Selection Tools

This is also the window in which specific font is chosen. When the Set Font button is depressed, a selection 
box appears, from which text style can be chosen.

Figure 4-13: Font Selection Dialog Box

NOTE: To choose Greek symbols (such as %, &, #, ', and () choose the Symbol font: 
a b c d e f g h i j k l m n o p q r s t u v w x y z
%&)*+,-./01#234'(56789:;<=
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Text Orientation

In the TEXT ORIENT window, select whether text should be oriented vertically, horizontally, or at an angle 
(in 15$ increments).

Figure 4-14: Text Orient Selection Tools

NOTE: Only rotate fonts that are True Type (indicated by TT in front of the name); other fonts (such as 
Courier and Fixedsys) do not re-scale properly, giving unpredictable results.

Drawing Tools

Once the object attributes have been defined, click the cursor on any of the drawing tool buttons to assign 
the function associated with that button to the mouse. The cursor will change from an arrow to a cross, 
indicating that AlphaView is in “drawing” mode.

After selecting a drawing tool, move the cursor to the correct position on the image to begin drawing. Press 
and hold the left mouse button and move the mouse to the end point of the object to be drawn. Release the 
left button, and the object should appear.

Boxes will appear at the corners of the new object and the cursor will revert to an arrow, indicating that 
AlphaView is now in “edit” mode. At this point, the object can be resized or repositioned. The color, pen 
thickness, line type, etc. can also be changed, simply by clicking on the desired choice (as described in “Object 
Attributes,” starting on page 91).
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To draw another object, click the right mouse button to return to “draw” mode, or click on one of the 
drawing tool icons.

Table 4-1: Drawing Tool Icon Descriptions

Icon Description

The selection tool, allows the user to select all drawing for further operations, such as vertical 
alignment.

The button labeled with an "ABC" adds text to the image. Place the cursor at the location on the 
image where the left edge of the text should appear. Click the left mouse button and begin typing. 
To place another piece of text, click where it should be placed. Once all text is entered, click on 
the right mouse button. To edit text, double-click on it. An edit window will appear, in which 
changes can be made. To change fonts, see “Text Background and Font,” starting on page 93.

The button labeled with a pencil icon allows the user to draw lines freehand. After clicking on the 
pencil, move the cursor to the correct position on the image to begin drawing. Press and hold the 
left mouse button. Using the mouse, move the cursor as if it were a pencil. When finished drawing, 
release the mouse button.

The button labeled with a diagonal line and arrow, draws arrows and straight lines. After clicking on 
the button, move the cursor to the position on the image where the line should begin. Press and 
hold the left mouse button. Using the mouse, move the cursor to the other end point of the line 
then release the mouse button. The arrow can be adjusted by clicking on one of the boxes at the 
end (the other will serve as an anchor point) or by clicking in the middle to drag the entire arrow.

The button labeled with angles and arrows on its side is a line drawing tool, very similar to the one 
described above. The significant difference is that this tool limits the angle that the line can be 
drawn to increments of 45$.

The button labeled with a square draws a rectangle or square of any size on the image. After 
clicking on the button, move the cursor to the position that should correspond to one of the cor-
ners of the rectangle. Press and hold the left mouse button. Using the mouse, move the cursor to 
enlarge the rectangle. When it reaches the desired size, release the left mouse button.

The button labeled with a circle draws a circle of any size. After clicking on the button, move the 
cursor to the position on the image where the circle should be started. Press and hold the left 
mouse button. Using the mouse, move the cursor to enlarge the circle. When the circle reaches 
the desired size, release the left mouse button.
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Hint: to draw a perfect circle around a portion of an image, first visualize a square surrounding the area of 
interest. Position the mouse in the upper left hand corner of the square. Click and drag the mouse down 
across the area of interest at a 45$ angle until the circle encloses the area of interest.

 

Sample Annotations

Figure 4-15: Sample Annotations

Annotated image showing: freehand drawings, lines with various characteristics, circles, squares, text with 
various characteristics

Editing Tools

When the cursor is in “edit” mode, it can be clicked on an object to select it. 

NOTE: The cursor can be toggled between “edit” and “drawing” modes by clicking the right mouse button. 

When an object is selected, small square boxes appear at the corners. Selected objects can be resized, 
copied, deleted or moved:
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• To resize an object, click on one of the gray boxes at the corners of its perimeter and drag the box 
until the object reaches the desired size. 

• To copy an object, use the Copy tool.

• To delete an object, use the Cut tool or the Eraser.

• To move an object, click within its boundary and drag it into the desired location. 

To select more than one object, outline them with the mouse; any objects that fall completely within the 
outline drawn will be selected. 

NOTE: The entire object must be enclosed by the cursor’s movement in order to be selected.

Figure 4-16: A Selected Object
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Table 4-2: Editing Tools

False Color
These tools consist of eleven pre-defined color palettes that can be applied to an image. To select a palette, 
simply click on one of the four buttons labeled Gray Palette, High-Low, Next or Previous.

Icon Description

Once an object or group of objects has been selected, clicking on the Cut tool deletes it from the 
image.

The Copy tool makes an exact copy of the selected object. The new object becomes the 
selected object, and can be repositioned by placing the cursor within the object’s boundary and 
moving it to the desired location.

The Horizontal Alignment tool aligns annotations in a straight horizontal line. This is especially 
useful for labeling lanes, etc. To use this tool, draw text on the image, select it, click the Horizontal 
Alignment tool, then deselect the text. The text will now be aligned in a straight line across the 
image.

The Vertical Alignment tool aligns annotations in a straight vertical line. This is especially useful for 
labeling markers, etc. To use this tool, draw text on the image, select it, click the Vertical Align-
ment tool, then deselect the text. The text will now be aligned in a straight line down the image.
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Figure 4-17: False Color Selection Box

When a palette is selected, its range of colors is displayed to the left of the palette buttons and automatically 
applied to the image. To apply a different palette to the image, click Next or Previous.

NOTE: Changes in Black level, White level, and Gamma setting can alter the effect of each of the palettes, 
and can enhance the results produced.

Gray Scale (Palette 0)

This is the default or standard gray scale, consisting of different gray levels, ranging from black to white.

High–Low (Palette 1)

This is a modified gray scale palette in which black is replaced with green, and white is replaced with red. 
Over- and under-exposed areas of the image are thus shown as green or red, while areas within the linear 
range of the CCD chip are shown in gray scale. The Saturation Palette is especially useful during quantitation, 
as areas outside the linear range of the instrument do not give accurate quantitative information. This palette 
allows the user to avoid those areas during quantitative analysis.

This palette can also be accessed by clicking the Show Saturation checkbox in the Camera Setup and Preview 
function (accessible by clicking on the Camera icon in the Tool Bar window)

Other Palettes

These are color substitution palettes in which the gray levels are translated into different color ranges. These 
palettes can be useful to help distinguish features and highlight details on an image. 
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• Palette 2 maps the gray scale levels to a red/green/blue palette. Values of 0 are mapped to red; 
saturated to blue, and values in between to green.

• Palette 3 maps the gray scale levels to a red/green/blue palette. Values of 0 are mapped to blue; 
saturated to green, and values in between to red.

• Palette 4 maps the gray scale levels to a red/green/blue palette. Values of 0 are mapped to green; 
saturated to red, and values in between to blue.

• Palette 5 maps the gray scale levels to a cyan/magenta/yellow palette. Values of 0 are mapped to cyan; 
saturated to yellow, and values in between to magenta.

• Palette 6 maps the gray scale levels to a cyan/magenta/yellow palette. Values of 0 are mapped to 
yellow; saturated to magenta, and values in between to cyan.

• Palette 7 maps the gray scale levels to a cyan/magenta/yellow palette. Values of 0 are mapped to 
magenta; saturated to cyan, and values in between to yellow.

• Palette 8 maps the gray scale levels to shades of red palette. This palette may be useful when viewing 
red color images.

• Palette 9 maps the gray scale levels to a red palette. Values of 0 are mapped to dark red; saturated to 
white, and values in between to shades of red.

• Palette 10 maps the gray scale levels to shades of blue palette. This palette may be useful when viewing 
blue color images.

• Palette 11 maps the gray scale levels to a blue palette. Values of 0 are mapped to dark blue; saturated 
to white, and values in between to shades of blue. This palette may be useful when printing an image 
of a Coomassie-stained protein gel onto a color printer.

• Palette 12 maps the gray scale levels to shades of green palette. This palette may be useful when 
viewing green color images.

• Palette 13 maps the gray scale levels to a green palette. Values of 0 are mapped to dark green; 
saturated to white, and values in between to shades of green. This palette may be useful when printing 
an image of a SYBR> Green I-stained protein gel onto a color printer.

• Palette 14 maps the gray scale levels to an orange palette. Values of 0 are mapped to dark orange; 
saturated to white, and values in between to shades of orange. This palette may be useful when 
printing an image of an EtBr-stained gel onto a color printer.
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Filter

Figure 4-18: Filters Toolbox with 3-D (Contour) Selected

AlphaView includes a variety of enhancement filters that can improve the appearance of an image. Some 
filters sharpen detail, others smooth and reduce random noise. Still others help visualize edges and separate 
closely spaced bands or objects. Depending upon the unique characteristics of an image, the results of each 
filtering operation vary. Assess the characteristics of the image and then select the filter designed to minimize 
its imperfections.

When an image is filtered, the original image information is replaced with the results of the filtering operation. 
As a result, the original image information is altered. To avoid losing the original image, save it as an original 
TIFF file before applying a filter.

When the FILTERS button is selected, a pop-up box appears. If the desired filter is not shown, choose MORE 
to display more filters. One or many filters can be applied to a single image. 

Figure 4-19: Filters Toolbox with Sharpen Highlighted
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Figure 4-20: Filters Toolbox with More Selected

General Information

To enhance an image, filters change the value assigned to each pixel. The new value assigned to a pixel is 
determined based on the values of the other pixels in its local vicinity (or “neighborhood”). The 
neighborhood is a two-dimensional matrix of pixel values, where each dimension has an odd number of 
elements. The “pixel of interest” is the one at the center of the neighborhood. This is the pixel whose old 
value is being replaced with a new one as the result of the filtering algorithm.

The pixels in a neighborhood provide information about the brightness trend. This information is important 
to the filtering process. The brightness trend is also referred to as the “spatial frequency.” Images with high 
spatial frequency content contain large, closely spaced changes in pixel values. For example, on a black and 
white checkerboard, the smaller the squares, the higher the frequency content.

Images with low spatial frequency content (for example, images of clouds) contain large areas of slowly 
changing pixel values.

Most of the filter options available (with the exception of the Noise filters) use a weighted summation process 
to determine the value assigned to the pixel of interest. Each pixel in a 3x3 neighborhood is multiplied by a 
“convolution kernel” having the same dimensions. The resulting sum is assigned to the pixel of interest.
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Each element of the convolution kernel is a weighting factor, also called a “convolution coefficient.” The size 
and arrangement of these weighting factors determine the type of transformation the image will undergo. 
Changing a weighting factor influences the overall sum and, therefore, affects the value given to the pixel of 
interest.

Sharpening Filters

These filters can increase image sharpness and provide edge enhancement. However image noise may be 
enhanced as well. These filters accentuate the high-frequency details of an image while leaving the 
low-frequency content intact. High frequency portions of the image get brighter while low frequency portions 
become black. 

Sharpen level 9 (high) has the largest effect on the image. Sharpen level 5 has an intermediate effect. Sharpen 
1 (low) has the most subtle effect on the image. 9 different sharpening levels are available for optimization of 
the image.

Noise Filters

This filtering process uses the values of the pixels contained in the area surrounding a pixel to determine the 
new value given to the pixel of interest. The noise filter sorts the pixels in the neighborhood into ascending 
order and picks the middle or median pixel value as the new value for the pixel of interest. Three levels of 
noise reduction are available.

Despeckle Filters

The despeckle filter is a type of smoothing filter based on data rejection. Pixels in the neighborhood (usually 
the adjacent pixels) are used as a data set upon which the average and standard deviation of the set are 
calculated. If the pixel of interest (the center of the neighborhood) is different from the neighborhood average 
(either greater or lesser) by a threshold (a multiple of the standard deviation) it is replaced by the average 
value. 

The effect of the filter is to “smooth” pixels that are much different from their neighbors. Artifacts such as hot 
pixels, cosmic rays etc. are commonly rejected by this type of filter. The filter strength is controlled by the 
threshold factor. For large factors very little data is rejected as only very large deviations are required for 
rejection, where as, low thresholds result in more smoothing. (For example, setting #1 results in outliers of 1 
standard deviation greater or lesser than the neighborhood average to be corrected for, setting #2 results in 
outliers of 2.5 standard deviations to be corrected for and setting #3 results in outliers of 5 standard devia-
tions to be corrected for.)

These filters are particularly effective in eliminating random noise contained in an image and produce less 
blurring than the noise filters.
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3-D (Contour) Filters

These filters are particularly useful for visualizing faint bands. They produce a “3-D” effect, defining edges and 
making details easier to see.

3-D level 9 (high) has the largest effect on the image. 3-D level 5 has an intermediate effect 3-D level 1 (low) 
has the least effect on the image. Nine different 3-D levels are available for optimization of the image.

In addition, 3-D allows the user to control the direction of the 3-D shadowing effect. Once the level is refined, 
just click on a direction arrow to visualize the shadowing adjustment. The default shadow direction is in the 
lower right hand corner direction and 9 different directions are available.

Figure 4-21: 3D Image Examples

Figure 4-22: 3D Image Controls
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Smoothing Filters

These filters are very useful for reducing the visual noise present in an image. When a smoothing filter is 
applied to an image, rapid changes in intensity are averaged out with the remaining pixels in the 
neighborhood, thereby decreasing the high frequency content. The visual result is a slight smoothing of the 
image because sharp pixel transitions are averaged with their surroundings. 

Smooth High has the largest effect on the image. Smooth Med has an intermediate effect. Smooth Low has 
the most subtle effect on the image.

Edge Filters

These filters use Laplacian enhancement to highlight edges, regardless of direction. All edge-enhancement 
operations attenuate the low frequencies of the image. Regions of constant intensity or linearly increasing 
intensity become black as a result of these transformations, and regions of rapidly changing intensity values are 
highlighted. 

NOTE: The White level may need to be adjusted after using the Edge filters in order to see the result of 
this filtering process.

Horizontal Edge Filter

This filter brightens horizontal edges. This can be useful in pinpointing bands on a gel. The horizontal edge 
filter (Horz. Edge) enhances image edges by shifting an image vertically by one pixel and then subtracting the 
shifted image from the original. In an area of constant pixel intensity, the subtraction yields black pixel values. 
At an edge, which is an area with large changes in intensity, the subtraction yields light-colored pixel values. 
The larger the difference in intensities, the lighter the resultant pixels. 

NOTE: After applying the horizontal edge filter the entire image may appear black, and might require 
reducing the White level in order to better visualize the results.

Vertical Edge Filter

This filter (Vert. Edge) brightens vertical edges using the approach described for the horizontal edge filter (see 
above), except that the image is shifted horizontally before the shifted image is subtracted from the original. In 
this case, the vertical edges produce light-colored pixel values. As in the horizontal edge filter, it may be nec-
essary to adjust the White level in order to better visualize the results of this filtering process.
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Custom Filter

This function allows the use of customized filters. Using the weighting factors of the other filters as a frame of 
reference, experiment with new weighting factor values. 

Undo Button

The upper right button is labeled Undo. This reverses the last filtering process applied to an image. To revert 
the image to its original state after multiple filters have been applied, press the Reset button on the main 
interface.

Examples of Filter Results

Figure 4-23: Examples of Filter Results

Movie Mode
To open and play existing movies, click on the Movie Mode tab in the Enhancement Tools. 
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Figure 4-24: Movie Mode In the Enhancement Tools

Click the Open button to open and play a previously recorded movie. To record a movie, click on the 
Record button. This will launch the Camera Setup and Preview window. Please refer to “Movie Mode” on 
page 34 for detailed instructions on recording movies.
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Chapter 5:

Image Analysis Tools

Chapter Overview
• Tool Box Analysis Tools Tab

• Molecular Weight Determination

• Colony Count

• Band Analysis Tools

• Lane Profile

• Additional Analysis Tools
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Tool Box Analysis Tools Tab
Default image analysis tools are contained within the Tool Box as indicated.   This tool set allows the user to 
perform molecular weight determinations, automatic counting of colonies and cells, multiplex band analysis 
and lane profile densitometry.

Figure 5-1: Default Analysis Tools in the ToolBox

Molecular Weight Determination
The Molecular Weight button (in Tool Box, Analysis Tools) opens a set of tools for entering the values of 
known molecular weight markers and determining the molecular weights of unknown bands on the image. 
When the Molecular Weight button is selected, a function box appears in the area to the lower left of the 
screen, and a data box appears on the image. (If the data window obscures part of the image containing 
bands of interest, it can be moved.)
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Figure 5-2: Molecular Weight Tools

Figure 5-3: Molecular Weight Data Box

At the top of the data box is a bar with two menus: Marker and Query. The area below the menu bar is 
divided into two sections. Molecular weight marker data is displayed in the upper section and the calculated 
or query data is displayed in the lower section.
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Entering Known Molecular Weights for Markers

An unlimited number of molecular weight standards can be defined, either all in one lane, or in multiple lanes. 
To input markers, open the Marker menu and select Add Marker. 

NOTE: To enter standards from previously-saved files, see “Applying a Set of Saved Markers” on page 115.

Notice that the cursor flashes and has a short, horizontal line associated with it. Move the cursor to the lane 
containing the molecular weight standards. Beginning at the top of the lane, position the cursor so the 
horizontal line is aligned with the band. 

If the Snap to Peak function has been activated, the cursor jumps to the highest pixel value in the band as 
the cursor approaches it. If bands are so tightly spaced that the line is not coinciding with the band, turn off 
Snap to Peak and place the marker on the band manually.

When the horizontal line is positioned correctly, click the left mouse button. A dialog box appears requesting 
the band's molecular weight. Using the numeric keypad in the dialog box (or the numbers on the keyboard), 
enter the known molecular weight. Alternatively, enter the value using the keyboard.

After entering the molecular weight, press either the OK button in the dialog box (or the <Enter> key on the 
keyboard). The dialog box disappears, the number of the band appears on the image, and the band's data is 
added to the Markers section of the data box. The horizontal red line remains, indicating that the cursor is 
ready to select the next band as described above. 

After entering the value for the last marker, click the Add Markers Complete button instead of OK. This will 
deactivate the value-entering function and will return the cursor to its normal mode. (To reactivate the value-
entering function, select Add Marker from the menu again, or click the right mouse button.)

The Molecular Weight Data Box

The data box is located near the top of the image. Initially, no values are displayed in the data box. When a 
molecular weight value is assigned to a band, the following information is displayed in the data box:

• Band numbers are assigned beginning with the first band, continuing in the order selected.

• The position corresponds to the band's location along the y-axis, ranging from 0 to 1030.

• The value displayed under the Molecular Weight. heading is the molecular weight value entered for a 
known and or the value calculated for an unknown band.

• The Rf value for each band is also displayed. Unless otherwise specified, AlphaView assumes the origin 
(Rf value = 0.00) is located at the top of the screen, and dye front (Rf value = 1.00) is at the bottom of 
the screen. Using these points as a frame of reference, AlphaView calculates Rf values for the interme-
diate bands.
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Figure 5-4: Molecular Weight Marker and Query Data

If the data box obscures part of the image, it can be resized or moved using Windows>?functions, or it can be 
hidden using the Hide Data checkbox.

Repositioning and Deleting Markers

Marker band indicators can be repositioned simply by positioning the cursor, clicking, and dragging the line to 
the desired location.

To delete a molecular weight marker, point the cursor at the appropriate marker band and click the left 
mouse button. This highlights the band in question by putting a red box around it.   (Alternatively, clicking in 
the data table highlights the marker’s information and selects the band on the image.)

Click on the Delete Marker function in the Marker menu. The marker is deleted, as is the band's data in the 
marker data table. Markers entered after the deleted bands are renumbered on the image and the data table.

To delete all the markers and start over, select the Clear Markers function in the Marker menu. 

Determining Molecular Weights of Unknown Bands

After marker values are entered, the molecular weight of any unknown band can be determined.
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Manually Selecting Bands

To indicate unknown bands manually, select the Add Band function from the Query menu. Just as in Add 
Marker above, a line will appear attached to the cursor. Point the cursor at the band of interest and click the 
mouse button. The molecular weight of the band is automatically calculated and displayed in the Queries 
section of the data box. 

To select a second band, click the right mouse button and the cursor line will reappear. Repeat this procedure 
for all bands for which molecular weights is to be determined. 

NOTE: The molecular weight markers appear in blue while the queries appear in green. 

The molecular weight of a band is calculated based on the graph of the known marker bands. 

NOTE: If a query band lies outside of the markers, it will be extrapolated in “Least Squares Fit” mode or 
given a value of “N/A” in “Point-to-Point” mode. For more information, see “The Graph Tool” on page 118.

Automatic Band Finding

AlphaView includes an algorithm for automatically finding bands in query lanes. To use this function, select 
Auto Query from the Query menu. A yellow vertical line will appear attached to the cursor. Position the line 
over the lane of interest and click the left mouse button. The bands in the lanes will be selected automatically, 
and their data will appear in the Data box. 

Repositioning and Deleting Bands

Bands can be repositioned simply by positioning the cursor, clicking, and dragging the band to the desired 
location.

To delete an unknown band indicator, point the cursor at the band and click the left mouse button. The band 
in question is highlighted. (Alternatively, clicking in the data table highlights the band’s information and selects it 
on the image.)

Click on the Delete Band function in the Query menu. The band will be deleted, as will the band's data in the 
query data table. Bands entered after the one deleted are renumbered on the image and the data table.

To delete all the queried bands, select the Clear Queries function in the Query menu.
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Using the Molecular Weight Standards Library

AlphaView contains a library of DNA and protein molecular weight standards. Additional sets of markers can 
also be added to this library for later access. For a complete list of pre-loaded files and the band sizes in each, 
see Appendix B, “AlphaView Molecular Weight Library Files“.

Applying a Set of Saved Markers

From the Marker menu in the data box, select Get Markers from File. A dialog box appears.

 

Figure 5-5: Get Markers from the Open Molecular Weight File Dialog Box

Using the left mouse button, click on the name of the file to be loaded. That name is then highlighted in the 
list and appears in the text box below the File Name: prompt. 

The current directory path is shown beneath the Folders heading. Below this is a graphical depiction of the 
path, and the sub-directories of the current directory. If the file of interest is in a different directory than the 
one open, double-click on the appropriate folder icon.

Once the file has been selected, click on the OK button to load the file. (Alternatively, double-click on the file 
name.) The dialog box disappears and a new dialog box appears.
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Figure 5-6: Load Markers Auto Load Dialog Box

This box gives the file name selected, as well as the number of markers contained within the file. It also give 
the user the option of auto-loading the file.

• If Yes is selected, a vertical line will appear attached to the cursor. Place the vertical line in the marker 
lane on the gel, and click. AlphaView will automatically search for the markers in the lane. In the above 
example, the brightest 7 bands in the lane would be selected, and the values for Boe II’s 100 bp DNA 
marker ladder would be assigned to the bands.

• If No is selected, AlphaView will display a cursor with a red line attached. Text in the upper right-hand 
corner of the image window will tell the user how many markers have been entered, and the value of 
the next marker to be entered.

Figure 5-7: Manual Load Dialog

To begin entering markers, move the cursor to the top band in the lane and align the horizontal line with the 
band. Click the left mouse button. Notice that the position for that band is added to the markers data table.

Move the cursor to the next band, click the left mouse button again to assign the next value in the series. 
Repeat this process until the values of all the marker bands are assigned.

To quit this function before all markers have been placed, click the right mouse button.

Adding a Set of Molecular Weight Markers to the Library

If the same set of molecular weight markers will be run repeatedly, there is no need to enter values on each 
new image. Instead, save the molecular weight values in a file and apply them to the marker lane of any 
subsequent images.

To save a set of molecular weight standards, click on Write Markers to File in the Marker menu after the 
marker values have been entered. 
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Following Windows conventions (255 characters or less), enter a new file name in the text box below the File 
Name: prompt. AlphaView will automatically give the appropriate 3-character extension.

The current directory path is shown beneath the Directories heading. Below this is a graphical depiction of 
the path, and the sub-directories of the current directory. If the file is to be saved in a different directory than 
the one open, double-click on the appropriate folder icon.

Alternate disk drives can be accessed using the Drives heading.

Once a name has been entered and the appropriate directory has been accessed, click OK. All of the marker 
values that are currently in the Data window will be saved to this new file. To access them in the future, follow 
the steps in “Applying a Set of Saved Markers” on page 115.

Special Functions 

Snap to Peak

This feature makes it easier to place the cursor on a band. If the Snap to Peak function has been activated, 
the cursor jumps to the highest pixel value in the band as the cursor approaches it. 

If bands are so tightly spaced that the line is not coinciding with the band, turn off Snap to Peak and place 
the marker on the band manually.

If the cursor is jumping to areas between bands instead of the bands themselves, check to see that the Bands 
Darker than Background checkbox is properly set.

Calculating Rf Values

To obtain accurate Rf values, specify the location of the wells (i.e., origin) and the dye front using the functions 
Set Well Pos./Start and Set Dye Front/End both found in the Marker menu. 

To designate the location of the wells, point the cursor at Set Well Pos./Start. Position the cursor so it is point-
ing anywhere along the wells and click the left mouse button. A horizontal bar appears, defining the location 
of the origin. By clicking and dragging, the bar can be moved for better positioning.

Repeat this procedure using Set Dye Front/End to indicate the location of the dye front.

Once the origin and dye front have been defined, they are used to calculate the Rf values of any bands that 
are added. If dye fronts are not assigned, AlphaView uses the top and bottom of the image as the boundaries 
for calculating Rf values.
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The Molecular Weight Cursor Box

Figure 5-8: Molecular Weight Cursor Box

The Molecular Weight Cursor box, found in the Molecular Weight toolbox, reports the location on the 
y-axis, the molecular weight and the Rf value of the current position of the cursor. These data are updated as 
the cursor is moved. This information can be helpful for positioning the cursor in a precise location, or for a 
quick estimate of a band’s size.

The Graph Tool

The Graph function is found in the lower left corner of the Molecular Weight tools box. 

Figure 5-9: Molecular Weight Tools
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Clicking in the Graph box displays the semi-log graph of the molecular weight data that is used to calculate 
the molecular weights of unknown bands. (To remove the graph window from the display, click on the Graph 
checkbox a second time.) The x-axis corresponds to the band's vertical location on the screen, and the y-axis 
is a log representation of molecular weight. By clicking on the appropriate button, the data can be toggled 
between a least squares fit and a point-to-point fit.

Figure 5-10: Example of Point-to-Point and Least Squares Fit Graph

The graph is useful to verify that the molecular weight data is entered correctly, and can help determine the 
most linear region of the molecular weight standards. Further, if a query band is clicked, its position will be 
shown on the graph by dashed lines (in Figure 5-10). 

Colony Count
The Colony Count tools in the Tool Box, Analysis Tools make it easy to count the number of objects on an 
image, such as colonies on a Petri dish or viral plaques.

Click on the Colony Count. The following sets of tools will be displayed in the lower left of the screen.
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Figure 5-11: Colony Count Tools

Figure 5-12: Sample with Two Types of Objects

When two types of objects are counted, the objects are highlighted in different colors. They can also be 
marked on the image using a “+” or an “X”.

Follow these three steps to perform an automatic colony count:

1. Define and Position Area(s) of Interest
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There are three drawing tools with which areas of interest can be designated. Click on the desired AOI (Area 
of Interest) button in the toolbox to define areas on the image containing the objects to be counted.

Figure 5-13: Colony Count Tools

Circles: This is the most appropriate choice for counting colonies on a Petri dish. After clicking on the button 
in the toolbox labeled with a circle, move the cursor into the image area to the edge of the Petri dish. Click 
the left mouse button and move the cursor to open the circle. When the circle corresponds to the perimeter 
of the Petri dish, release the mouse. The circle has “handles” around it, and can be moved or re-sized at this 
point. 

Hint: To draw a perfect circle around a portion of an image, first visualize a square surrounding the area of 
interest. Position the mouse in the upper left hand corner of the square. Click and drag the mouse down 
across the area of interest at a 45$ angle until the circle encloses the area of interest.

Rectangles: After clicking on the button in the toolbox labeled with a square, move to one of the four corners 
of the region to be enclosed. Click the left mouse button and move the cursor to the corner diagonally oppo-
site. 
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NOTE: The box that opens as the cursor moves. Release the left mouse button when the box has reached 
the desired size. The rectangle has “handles” around it, and can be moved or re-sized at this point.

Freehand Drawings: To draw a freehand object, select the freehand icon; the mouse will change to a pencil. 
Draw an object of the desired size and shape. When the mouse is released, the start and end points of the 
object will be connected.

Manipulating Areas of Interest: Areas of interest can be moved, copied and deleted. To perform any of these 
functions, an area must first be selected by clicking on it or dragging the cursor around it. Its color changes to 
gray, indicating that it is active. More than one area of interest can be selected at any given time.

To move an area of interest click on the selected area. While holding down the left mouse button, drag the 
area to the desired location.

To delete an area of interest click on the cut button in the toolbox (designated by a pair of scissors). The 
selected area of interest is removed and any other areas of interest are renumbered accordingly.

To copy a selected area of interest, click on the copy button (found next to the cut button). A second copy of 
the area of interest appears overlapping the first one. Click and drag the copy to the desired location.

2. Set the Density Thresholds

The objects counted by the automatic counting routine are based on the difference in the gray levels of the 
objects as compared to the background (e.g., the colonies on the petri dish are either darker or lighter than 
the surrounding area). The density thresholds define the gray levels that are recognized by the counting 
routine.

To set the density threshold, click and drag the sliders. As the sliders are moved, the regions of the image that 
fall within the gray scale range are highlighted in the image area. Adjust the slider positions until the objects to 
be counted are highlighted. The numbers next to the Min and Max settings change to reflect the positions of 
the sliders. These numbers represent the minimum and maximum gray scale values that are currently being 
detected. Any object whose gray level falls between these two numbers will be counted.

If there are two sets of objects to count, click on the second colony count button (next to the Count button) 
and adjust the density threshold so the second set of objects are highlighted.

3. Count the Objects

When the density threshold settings and size settings are satisfactory, click on the Count button. If two types 
of objects are to be counted, click the second colony count button and click Count again. The counts are 
shown for each area of interest and the totals are given in an colony count display window on the image.
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Figure 5-14: Colony Count Sample Results for an AOI

Editing Tools

After the objects have been automatically counted, AlphaView will automatically open the Edit Tools 
functions. If editing is necessary, these tools manually override decisions made by the automatic counter.

Figure 5-15: Colony Count Editing Tools

Displaying Spots

Spots are displayed as red (or green) numbers on the image. These can be changed to symbols (“+” or “x”) 
by holding the <shift> key and clicking the right mouse button. Repeat to return to numbers.

Spots can be hidden from view by checking the Hide Spots checkbox.
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Specify the Size Range of the Objects

If the image has objects of different sizes but only those in a certain size range are of interest, use the Area 
Controls. 

Specify the size range by adjusting the minimum and maximum diameter settings. The numbers below the 
Min. Area and Max. Area headings indicate the minimum and maximum diameter settings in pixels. Any object 
whose diameter falls between these two numbers will be counted. 

As these number are changed, objects will be added to (or deleted from) the display, and the Count windows 
will be updated.

Using the Add Spot Tool

Occasionally, the automatic counting function may fail to count an object on the image. This could occur for a 
variety of reasons, including inappropriate Density and Size Threshold parameter settings. 

Objects can be added to the total count numbers using the Add Spot button. Click on the appropriate count 
box (red or green). Next, click on the Add Spot button. Point the cursor at the object to be added and click 
the left mouse button. The object will be highlighted and the count will automatically increase. 

Figure 5-16: Results of Colony Count After Manual Addition of Three Spots

To add a second object, click on the right mouse button to re-enter “add” mode, then click on the desired 
object with the left mouse button.

Using the Erase Spot Tool

This function removes any extra spots that were counted either automatically or manually. For example, if a 
portion of an AOI has high background or other noise, a number of objects may erroneously be included in 
the count. Draw a box around the object or set of objects. Objects will be displayed with a white background 
to indicate that they are selected. Clicking Erase Spot deletes all selected objects at once and automatically 
reduces the total count information. 
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Spot Count Data

When AlphaView opens, the Colony Count data box is hidden. To display spot count data, click the checkbox 
to deselect Hide Data. The following data window will appear:

Figure 5-17: Colony Count Data Window Showing AOI Summary Data

This window shows the summary data for the Area(s) of interest (AZ). This includes the threshold values that 
were set for each count type, the number of objects found for each count type, and the total pixels in all of 
the spots.

To see specific details on each spot, click View > Spot Details. Figure 5-18 displays an example of what 
displays: 

Figure 5-18: Selecting the Colony Count Data Window to Show Individual Spot Details

The data table gives the individual spot number, the AOI in which it was counted, its coordinates, the 
integrated density value (IDV) for each spot, the area (number of pixels) for each spot, and the % contribution 
to the total. 
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NOTE: Manually-added spots show areas of 1 pixel.

Band Analysis Tools
In the ToolBox, Analysis Tools, a tab labeled Band Analysis opens a set of tools with which the density of 
bands, spots or other objects can be measured. A two dimensional area of interest (or Object) is created and 
the density is obtained through the corresponding pixel intensity values designated as IDV or Integrated Den-
sity Value. 

Figure 5-19: Band Analysis Object Tab

Creating an Object Area of Interest 

Object Boxes: 

An area of interest can be created in several ways. The user can manually draw an area of interest through the 
three OBJECT buttons. Objects can be enclosed with a box (rectangle), ellipse, or freehand drawing. Select 
the one that most closely corresponds to the shape of the objects on the image. 
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To draw a rectangle or ellipse, click on the button labeled with a box (or a circle) beneath the OBJECT header 
in the toolbox. The cursor automatically changes to a “+” when it is in the image area, indicating that 
AlphaView is in “drawing” mode. Move the “+” to the corner of the object to be measured, click the left 
mouse button, move the cursor, and release the mouse button when the box (or circle) surrounds the object. 

Hint: To draw a perfect circle around a portion of an image, first visualize a square surrounding the area of 
interest. Position the mouse in the upper left hand corner of the square. Click and drag the mouse down 
across the area of interest at a 45$ angle until the circle encloses the area of interest.

 

To draw a freehand object, select the freehand icon; the mouse will change to a pencil. Draw an object of the 
desired size and shape. When the mouse is released, the start and end points of the object will be connected.

Once the mouse is released, the cursor changes to an arrow (indicating that AlphaView is in “edit” mode), 
and the object is shown in gray with handles around it. The object can now be resized using the handles or 
repositioned by clicking within the boundaries and dragging to a new location.

To draw another object, return AlphaView to “drawing” mode by clicking the right mouse button.

If a box or ellipse is large and includes significant background area, the corresponding density value may be 
large. The higher the background, the greater its contribution to the total of pixel values in that object. There-
fore, objects should be drawn so that they fully enclose areas of interest, but do not include an excessive 
number of background pixels or pixels from neighboring regions:

Figure 5-20: Drawing Objects Examples

Hint: Keeping the data window open can reduce the speed at which objects are drawn and manipulated 
on the screen. Therefore, it may be preferable to hide the data window until all objects and backgrounds 
are drawn and in place.
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Hint: Accurate Local Background Correction method requires the object box to contain a few pixel values 
that are true representations of the background level. If the object is too small and the band fills the object 
box then local background correction will result in significant errors.

Magic Wand and AutoSpot

These two selections are automated detection features designed to recognize sample in an image and draw 
Object boxes around it. They are found under the Auto Detect heading in the main Band Analysis. Tab. Once 
an object is created the dimensions can be altered and the background subtracted similar to manually drawn 
objects.

Figure 5-21: Magic Wand and AutoSpot Tools

Magic Wand

Selecting Magic Wand will activate a wand like symbol and the following data table:

Figure 5-22: Magic Wand Parameter Window
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The tip of the wand should be centrally positioned over the sample spot on the image and then simply click 
the mouse. The software will use either an “edge detection” algorithm to trace an area of interest around the 
spot or draw a box around the sample. A right mouse click will reactivate the wand icon for another selec-
tion.

Magic Wand Sensitivity

The Magic Wand Sensitivity slide bar will alter the parameter for how much of the spot will be detected. The 
slide bar ranges from 0 to 100. The smaller the number the less of the spot the software will define. The 
greater the sensitivity number the more of the object the software will find.

HINT: Selecting a brighter pixel within the band (or spot) will have magic wand draw a tighter area of inter-
est. Correspondingly, a less intense pixel will draw a larger perimeter around the selected spot.

Spot Type

Under the Spot Type heading the Bright Spots selection should be checked if the image contains bright spots 
on a dark background (e.g. ethidium bromide stained fluorescent gels and chemiluminescent blots). The Dark 
Spots selection should be made when the sample contains dark sample on a light background (example: film, 
Coomassie blue protein gels). The software should automatically determine this selection, but some manual 
intervention may be necessary. Remember as in all portions of AlphaView software if the image has been 
reversed (negative image) using the Reverse selection on the Contrast Adjustment window the Dark Spot 
selection should not be made. Reverse is a visual alteration only and does not affect the original image capture 
data. (e.g. a chemiluminescent blot is captured using the Reverse mode in order for it to appear as film, the 
correct selection is still Bright Spots).

Outline Type

Border Outline will use the edge detection methods to determine the spot area. Box Outline is the default 
setting and will draw a box shape around the sample usually including a significant portion of background. 
User preference and image particulars will determine which outline type is best.
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Previous Location

Previous Location will automatically select the spot on the image last selected for magic wand and apply any 
changes made for sensitivity. This feature is designed to quickly evaluate how the different sensitivity numbers 
will affect the drawn area using the same selected point in a spot. The X,Y coordinates are given for the 
previous spot as well. 

Exit

Exit will remove the Magic Wand Parameter window. 

Auto Spot

Auto Spot is a feature designed to find multiple spots within a region of interest. It is accessed through 
AutoSpot under Auto Detect in the Multiplex Band Analysis tab. Once it is selected the following tab will 
appear and the cursor will be ready to draw an area of interest.

Figure 5-23: Auto Spot

Area of Interest

After selecting AutoSpot an area should be drawn on the image by clicking and dragging the mouse. The 
smaller and more defined the Area of Interest is, the better the resulting data.   The area can be manipulated 
using the manipulation tabs at the edge of the red box. 



Band Analysis Tools page 131

FluorChem HD2 and FC2 User Guide

Options

The Options selection allows either a box outline to be drawn around the spots or a border outline. The box 
outline is the default setting and will include more of a background in the drawn area than the border outline. 
User preference and image particulars will determine which outline type is best for sensitivity can also be 
adjusted by sliding the bars for normal spots (<98% saturation) and for saturated spots (>98% saturation).

Figure 5-24: Auto Spot Options

Bright Spot vs Dark Spot

The Bright Spots selection should be checked if the image contains bright spots on a dark background (e.g. 
ethidium bromide stained fluorescent gels and chemiluminescent blots). The Dark Spots selection should be 
made when the sample contains dark sample on a light background (film, commassie blue protein gels etc.). 
The software should automatically determine this selection, but the user may have to override it if the 
software incorrectly evaluates an image. Remember as in all portions of AlphaView software if the image has 
been reversed (negative image) using the Reverse selection on the Contrast Adjustment window the Dark 
Spot selection should not be made. Reverse is a visual alteration only and does not effect the original image 
capture data. (EG if a chemiluminescent blot is captured using the Reverse mode in order for it to appear as 
film, the correct selection is still Bright Spots).

Find Spots

The Find Spot button is selected once the correct area of interest is drawn and the Bright Spot/Dark Spot 
selection is correctly made. A green outline will be drawn around the detected spots. 
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Background Threshold

The background threshold slide bar will adjust the criteria used for finding spots. It is on a scale of 0 to 100% 
saturation. The sliding bar maps the dynamic range of the camera. By calculating the fringe pixels in the image 
or ROI, the initial threshold value and suggested lower (or upper) bound value are calculated and shown on 
the sliding bar. The user can always override the threshold value by moving the sliding bar or typing in the 
counter box.

Target Size

The user can input the minimum and maximum area in pixels of the spots or bands of the desired targets. The 
default values are 1 pixel minimum and no limit for maximum pixels.

Get Data

Get Data is selected once a satisfactory spot outline is achieved. This will convert all drawn objects into 
standard Spot Densitometry objects with associated density numbers.

Manipulating Objects

Selecting Objects

To select an object, click on it with the mouse. “Handles” will appear at its corners.

Figure 5-25: Non-Selected and Selected Objects

To select a second object instead of the first, click on the desired object.

To select more than one object at a time, drag the mouse around all of the objects of interest. 

NOTE: An object must be completely surrounded by the mouse operation in order to be selected.

To select more than one object where it is not feasible to drag the mouse around objects, hold the <shift> 
key and click on each object to be selected.
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To de-select an object, click the left mouse button outside of the selected object. The handles disappear, 
indicating that the object is no longer selected.

Copying Objects

To draw boxes or ellipses enclosing the same number of data points, use the Copy function. 

First, draw or select an object of the desired shape and size as described above. Next, click on the Copy but-
ton in the toolbox. A duplicate of the selected object will appear on the screen. This object can then be 
moved to the desired position. 

To make multiple copies of an object, continue to click on the Copy button until the desired number of copies 
is displayed.

Moving Objects

An object can be moved to fine-tune its position simply by clicking on it, holding down the left mouse button 
and dragging it to the desired location.

Deleting Objects

To remove an object or set of objects, select the object(s). Select the Delete button on keyboard. All the 
selected objects are removed from the image window and their associated data is cleared from the data 
window.

Band Analysis Measurements

As objects are drawn, their density data is automatically calculated and displayed in a data window. Any time 
an object is drawn or detected, the data in the window are updated. If the Band Analysis Results window 
obscures a region of interest, resize and/or move it following Windows conventions.
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Figure 5-26: Example of a Band Analysis Data Window

Data Definitions
Please refer to Appendix C, “Data Description Tables“ for a complete listing and description of the various 
quantities.

# is the number assigned to each object on the image in the order in which they were drawn. This object 
number is also shown in the corner of the object.

IDV is the sum of all the pixel values after background correction:

IDV = @(each pixel value - BACK)

% is the percentage that each box, ellipse, or freehand drawing contributes to the total density measured thus 
far, taking background correction into consideration. The sum of the values in this column will be 100.

Area is the size (in pixels) of the region enclosed by the box, ellipse, or freehand drawing.

Average is the average value (after background correction) of the pixels enclosed.

AVG = IDV ÷ AREA

Background is the background value that will be subtracted from all the pixels in the object. (See “Back-
ground Tab–Calculating Background Values” on page 135 for more information.)

Inverting Data

The Invert function reverses the gray scale assignments so that 0 corresponds to white and 4,095 
corresponds to black. This control is found on the Region tab.

If the image has dark bands and light background, then Invert should be selected by placing an “X” in its box. 
If the image has light bands and dark background, the Invert option should not be activated.



Band Analysis Tools page 135

FluorChem HD2 and FC2 User Guide

NOTE: This function does not alter the appearance of the image (unlike the Reverse button described in 
Chapter 2, “Getting Started—Basic Imaging Functions“).

Background Tab–Calculating Background Values

Background subtraction is an important part of image densitometry analysis. There are three background sub-
traction options in the Band Analysis tools.

IDV = @(each pixel value - BACK)

Figure 5-27: Background Tab

No Background

If no background calculation method has been selected, the background value in the data window (BACK) is 
reported as zero (0). Therefore, the object’s integrated density value will be equal to the sum of all the pixel 
values within the box, ellipse, or freehand drawing. Recommendation: No Background or Manual Background 
is suggested for AutoSpot, Magic Wand (only the border outlines though) or any object where little if any 
background is included in the object area of interest. 
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Automatic Background

When the Auto Background function is active (an “X” appears in the checkbox), AlphaView determines the 
average of the 10 lowest pixel values in each individual object and assigns that value to BACK. This option is 
useful if the image has regions with different background levels, because the background values (BACK) will be 
unique for each object.

NOTE: If Auto Background is active, it will override the manual background option (described below).

Manual Background

Using this option, different region(s) of the image representative of different background densities can be 
specified. Further, the user can specify exactly which objects of interest should correspond to which back-
ground objects.

To manually specify the background, use the buttons beneath the Background heading in the Band Analysis 
toolbox to draw a box (or ellipse or freehand drawing) around an area representative of background density. 
If the background varies across an image, draw several background objects in order to represent each of the 
various background levels.

Next, specify the object(s) from which each background density should be subtracted. To associate a back-
ground with an object(s), select the object(s) and the background as described in “Selecting Objects” on 
page 132. When all are selected, click on the Link Bckgrd button in the Band Analysis toolbox. All the objects 
will assume the color of the background object, indicating that they are associated with each other. 

Figure 5-28: Using Manual Background to Assign Different Background Values to Different Objects: Objects 1-5 are linked to 
B1; 6-7 to B2; 8-9 to B3

In the Band Analysis data window, these objects now show a non-zero background density value in the BACK 
column. 
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To disassociate an object from its background, select the object and click on the Unlink Bckgrd button. The 
object reverts to its original color, indicating that it is no longer associated with any background box or ellipse. 
The object's value in the data window changes and its entry in the BACK column returns to zero.

Note: If Auto Background is active, manual background settings will be overridden.

Mass Standard Calibration Curves for Quantitative PCR

The button in the Band Analysis toolbox labeled Std Curve opens a set of tools that create a calibration curve 
for applications such as quantitative PCR. The calibration curve functions allow quantization of the bands on a 
gel based on a set of standards. A minimum of two standard bands must be input, but the accuracy of the cal-
ibration curve increases as the number of standard bands and their range of values increase.

Defining the Bands as Objects

Before generating a standard curve, define the bands using the object drawing tools in the Band Analysis tool-
box. As described in “Selecting Objects” on page 132, the size of an object can influence the integrated den-
sity value. Therefore, we recommend using the same sized box, ellipse or freehand drawing when defining a 
standard curve. (For instructions, see “Copying Objects” on page 133.)

Specifying the Quantization Units

Once the objects are defined, click on the Std Curve button. The Standard Curve Toolbox will appear in 
which the results should be reported (e.g. ng, 2L, pg, %) in the Enter units box
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Figure 5-29: Standard Curve Tab

Designating the Standard Bands

Click on one of the bands whose value is known. In the dialog box displayed, enter the value for the band, 
using either the keyboard or the numeric keypad in the dialog box. When the entry is correct click on the OK 
button. The band number changes from white to green, indicating that it is now a standard.

To enter the next value, click on another band. The dialog box will open again and will show an estimated 
value (based on the object’s IDV value and on the standard value already entered). Click OK to accept this 
value, or enter a value.

Figure 5-30: Entering the Value for a Standard Band
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Once the second value has been entered, a curve is displayed. The points corresponding to the standard 
bands are labeled in yellow. Points for the unknown objects on the image are displayed on the standard curve 
based on their integrated density values. These are labeled in white.

Figure 5-31: Standard Curve

Enter values for each band whose amount is known. As more standard points are added, the calculated values 
of the unknown points may change. 

To remove a band from the set of standards, click on it again. The band number changes from green back to 
white, indicating that it is no longer a standard. To de-select all the standard points at once, click on the Clear 
Std Pts button in the toolbox.

To change the value of a standard band, click on it twice. In the dialog box, the estimated value for that band 
is displayed. Accept this value by clicking OK, or enter a new value.

Displaying the Curve

If the box displaying the standard curve obscures a part of the image, it can be resized using Windows oper-
ating system functions. It can be hidden from view by clicking the Hide Curve checkbox in the Standard Curve 
toolbox. 

Quantization Values of Unknown Bands

As the values for the standard bands have been entered, the quantitation values of the unknown bands are 
automatically calculated. To see the calculated values of the unknowns, click on the Exit button in the standard 
curve toolbox. This returns to the Band Analysis tools and data box. 
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Note: The graph is based on a Smoothed Cubic Spline fit. To use other curve-fitting methods, exports the 
data table as an ASCII file and open it in any statistical analysis package.

Figure 5-32: Band Analysis Data Box

The third column in the data box contains values for the standards (entered by the user), and the values for 
the unknown bands (calculated based on the curve). The heading of this column reflects the units entered as 
in “Specifying the Quantization Units” on page 137

An “n” next to the object number indicates that the objects are unknowns (or non-standards) whose value 
has been interpolated. An “a” means that the object lies outside of the curve, and its value has been approxi-
mated through extrapolation. Standards have an “s” next to the object number, and are highlighted in green 
to differentiate them from unknown bands.

Lane Profile
The Lane Profile option in the Analysis Tools tab of the ToolBox accesses a set of densitometry and 
molecular weight determination tools with which bands on a gel can be automatically analyzed in a lane for-
mat. 

When Lane Profile is selected, the Lanes tab is displayed with the following functions:
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Figure 5-33: Lane Profile Lanes Tab

Profile Path Width 

The Profile Path Width is the area from which the pixel density is measured. The default setting is 10. To 
adjust the setting, click on the up or down arrows or enter a value and hit the enter button on the keyboard. 

The density values for Lane Profile graphs are determined by the average pixel density between the blue lines 
on the template. 

A Profile Path Width that is too narrow may not include enough information and can result in a noisy 
graph. By contrast, a Profile Path Width that is too wide can incorporate background pixels that will 
reduce the pixel average and dilute the actual data.

Auto Lane Detection Using an Area of Interest

AlphaView can automatically detect and analyze the lanes and bands in the area of interest specified by the 
user. To draw an area of interest, click and hold the mouse and draw a box around the sample area of interest. 
Image artifacts (well position marks, etc.) should not be included in the box as AlphaView may record them 
as bands. After an area of interest is drawn, click on the Detect Bands button in the Lanes tab. AlphaView 
will automatically detect the lanes and analyze the bands in the area of interest. 
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Figure 5-34: Area of Interest Drawn

Manual Lane Detection

Select the Manual Lanes checkbox to manually detect the lanes on the image. Once selected, the Auto 
Grid template will appear on the image. 

Figure 5-35: Lane Profile Auto Grid Template
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Setting Up the Lane Profile Template

Red lines in the Auto Grid template indicate borders of adjacent lanes. Green lines define the Profile Path 
Width. 

Manual Lanes Box
Select the Number of Lanes up to a maximum of 24 lanes. When the number of lanes is adjusted, the 
template displayed on the image is updated accordingly. 

If the lanes on the gel are horizontally oriented (sideways) the image can be rotated. To change the orienta-
tion of the image to coincide with the template, click on the Enhancement Tools tab in the Toolbox and 
select the Rotate-Flip option. Click and drag the rotation bar +/- 90 degrees until the desired orientation is 
reached.

After specifying the correct number of lanes and changing the image orientation, adjust the outside borders of 
the template until they frame the lanes to be scanned. To do this, first click on the template. Next, select any 
of the blue boxes along the outside border of the template and drag it until the desired size is reached. Adjust 
the template until the border of the template frames the lanes to be scanned and the red lines lie between 
each of the lanes.

If the lanes of the gel are not perfectly straight, click the Skewing checkbox in the Manual Lanes box. The 
template will display four blue boxes, one at each corner of the template. Click and drag the blue boxes as 
needed until the template is positioned properly over the skewed lanes.

Figure 5-36: Skewed Lane Profile Template Properly Aligned on a Gel

Profile Path Width
Adjust the Profile Path Width value as needed. The path width should not exceed the band edges and cannot 
extend beyond the red lane borders. As this value is changed, the template displayed on the image updates 
accordingly. 
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Bands Darker than Background Option

Select the Bands darker than background checkbox if the image being analyzed has dark bands/signal on 
a white background which are usually colorimetric gels. The Bands darker than background option is 
only necessary when the actual sample has signals that are visible by the naked eye, for example Coomassie 
Blue stained gels, Silver stained gels, and pieces of autorad film.

Image Analysis–Detect Bands

Select the Detect Bands button to automatically measure and calculate the densities of each lane. To have 
AlphaView detect all bands in the image automatically select Detect Bands immediately after opening an 
image. Otherwise, select Detect Bands after drawing an area of interest or after the Manual Lane settings 
and template have been adjusted. 

Viewing Results

Once the Detect Bands button is selected, AlphaView automatically analyzes the image, detects the peaks 
for each lane, integrates the area under each peak, displays results and moves to the Bands tab. 

Figure 5-37: Lane Profile Bands Tab

Peak integration adjustments that can be made manually will be described in detail later in this section. The 
Analyzed Image and the Lane Profile Results windows are displayed. 
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Analyzed Image

Individual bands will be identified by number on the analyzed image. When a lane is selected in the image its 
borders will turn pink. The corresponding lane data will be displayed in the Lane Profile Results windows.

Figure 5-38: Analyzed Image

Lane Profile Results Windows

The following results windows will also be displayed after the image is analyzed. These windows can be 
resized or docked by the user if desired: 

• Data Table (middle). The Data Table displays peak information for each lane in the image. 

• Lane Graphs (lower left). This area displays a graph for each lane. 

• Active Graph (lower right). The active graph displays peak numbers and integration data for the lane 
selected.

To view data and the Active Graph for a lane, select a lane either from Analyzed Image or from the Lane 
Graphs. To view peak data for a specific band, select the band in the Analyzed Image or the peak from the 
Active Graph. The corresponding data will be highlighted in the Data Table. AlphaView uses the following 
color-coding to indicate what data is being displayed:

• The lane graph that is currently selected will be grey. 

• The data for the currently selected lane will be highlighted in yellow in the Data Table. 

• The data for the currently selected band or peak will be highlighted in dark yellow in the Data Table, 
and the peak fill in the Active Graph will also be dark yellow.
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Figure 5-39: Results showing Color Coding in Data Table (top), Lane Graph (lower left) and Active Graph (lower right)

Lane Graph Display
Graphs representing all Analyzed Image lanes are shown in this area. After band detection, Lane 1 will be 
selected by default and its corresponding peak data will also be displayed in the Data Table and Active Graph. 
To view data for a different lane simply click on its lane graph. 

When the image contains many lanes, there may be too many graphs in the Lane Graph display to see rea-
sonable detail. To reduce this view to only four lane graphs, select the Options menu directly above the Data 
Table and deselect Show All Lanes.

Figure 5-40: Deselecting Show All Lanes
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Active Graph
The Active Graph is shown in the lower right. The x-axis represents the distance (in pixels) from the top of 
the area of interest drawn or the Auto Grid template used. The y-axis represents the average pixel intensity 
across the width of the scan. 

NOTE: Active Graphs are shown without axes in order to show as much detail as possible in a small win-
dow. To show the graph’s axes, choose Show Axes from the Show Single Lanes option in the Options 
menu located above the Data Table. 

Data Table
Once a peak is defined, its integration data and associated information are displayed in the Data Table. The 
data table is updated automatically when peaks are added or deleted, when peak boundaries are redefined, or 
if the background value is reset.

Figure 5-41: Example Data Table

The Data Table contains the following columns of data:

• LANE indicates the lane number where the peak is located. 

• PEAK is the number assigned to each peak on the graph. 

• DISTANCE is the migration distance (in pixels) for each peak as measured from the top of the 
region used for data analysis.

• WIDTH and HEIGHT are the calculated peak width and peak height.

• AREA is the integrated pixel intensity for the area under each peak and can be used to represent 
band intensity.
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• % is the percentage each peak contributes to the total density. The sum of this column will be 100% 
for each lane.

Lane Profile Results Menu

The drop down selections at the top of the Data Table (Data, Baseline and Options) allow for the user to 
perform editing, visualization and outputting tasks pertaining to the Active Graph window.

Figure 5-42: Visualization of the Active Graph

Data
The Data drop down menu allows the user to superimpose different lanes onto the Active Window using 
the Overlay Control selection. For detailed instructions, see “Overlaying Graphs” on page 153. Print will 
allow the user to print any or all of the profile and data table windows. Clipboard will allow the user to send 
any or all of the profile and data table windows to the clipboard for pasting into different programs (e.g. 
Excel). 

Baseline
Baseline manipulation and background subtraction can be performed using this menu. For detailed instruc-
tions, see “Adjusting the Baseline” on page 150. 

NOTE: Background subtraction can have a dramatic effect on how many peaks are recognized as bands. 
Try changing the background subtraction to optimize band recognition.    

Options
Selecting Show Data will display the Data Table. Selecting Show Single Lane will display the Acitve Graph. 
Selecting Show All Lanes will display the Lane Graphs. From the Show Single Lane menu option, Back-
ground Color allows the user to select a variety of different background colors for the Active Graph. Show 
Axes allows the user to display the axes on the graph. Show Image Strip will display a strip of the lane 
being currently analyzed. 
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Figure 5-43: Options > Show Single Lane Menu

Editing Peaks

Editing Peak Boundaries
The boundaries of existing peaks can be readjusted to make the peaks wider or narrower. To adjust either 
peak boundary, click on the peak to select it. Next, point the cursor at the vertical boundary line, hold down 
the left mouse button and drag the line to the desired location. When it is in place, release the mouse button. 

The data table is automatically updated to reflect any adjustments. Both the peak and the data in the data 
table will be blue to indicate that this is a user-defined (vs. automatically detected) peak.

Visualizing Peak Placements
To determine exactly where a peak is located relative to the original image, it is often helpful to see the graph 
and the gel image in the same orientation. The Show Strip function (found in the Options menu) displays the 
area of the gel that has been defined as a lane across the length of the x-axis.

Figure 5-44: Graph With Show Strip Selected

NOTE: If Show Strip fails to show a portion of the image, check that the appropriate driver for the VGA 
card is selected. 
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Adjusting the Baseline

As a default, the baseline value is set to Auto Base. As the baseline is adjusted, the values for all peaks are 
updated to reflect the new baseline.

All of the following functions are found in the Baseline menu under Background Subtraction:

Auto Base
This method breaks the red line defining the left boundary of the lane into sixteen regions, and outputs 
sixteen points which reflect the average backgrounds across those sixteen regions. The user can manipulate 
the 16 points by clicking and dragging. The user may also designate more points than the 16 and manipulate 
those in the same fashion.

Intra-Lane
This method uses the lower of the two values at the edges of the lane along its travel as the background. If the 
section of the image is used is wider than the bands, then this is a very effective way of removing co-migrating 
material from your measurements. This method should only be used if the bands are completely enclosed. 
This is because when the edges of your lane area intersect any of your bands, band material will be consid-
ered as background, severely affecting your results.

Rubber Band
This method can be thought of as stretching a rubber band underneath the lane profile. This option does not 
work well if the values at the ends of the intensity profile are lower than the rest of the intensity pixels. We do 
not recommend this method for images with poorly separated bands.

Minimum Profile
This method takes the lowest value on the profile of each lane as the background for that lane. We do not 
recommend this method for lanes where the beginning or end of the lane is the lowest point as this is 
dependent on where the lane boundary was placed when it was defined. This can be hard to repeat between 
analysis of the same gel.

Valley to Valley
This method requires that you have performed band detection first. The background is taken as the line 
between the edges of the bands in the lane. You enter a value (see “Set Parameters” on page 151) of 
maximum slope in the accompanying entry box to avoid situations where the edge between overlapping 
bands, which is not at the background intensity, causes the background to climb too high.
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Rolling Disc
This method requires you to enter a parameter for the size of the disc (see “Set Parameters” on page 151) in 
the entry box. This option calculates the background as if a disc, with the radius you have entered, were 
rolling underneath the lane profile. The larger the radius of the disc, the less the background rises with the 
profile.

Set Parameters

Figure 5-45: Background Subtraction Parameters Dialog Box

This dialog box is used to change values for Rolling Disc and Valley to Valley background methods.

Base Lock
The Base Lock function will designate the active graph baseline for all of the lanes in the data table. To de-
select this option click on the Base Lock a second time. The check mark will disappear.

Horizontal Base
Activating the Horizontal Base function will move the baseline to the 0 position (no background). The base-
line can be moved vertically by clicking the baseline and dragging it upwards. 

Reset Base
Activating the Reset Base function will move the baseline to the 0 position (no background). Unlike Horizon-
tal Base the baseline cannot be moved. 

Base Subtract
This selection will subtract the current baseline from the intensity value line. Un-check Base Subtract to deac-
tivate this feature.

Interpreting Lane Profile Data

AlphaView provides a variety of tools to help interpret Lane Profile scan data. 
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V. Line
Typically, the peaks on a graph correspond to the bands in a lane. The V. Line tool located in the Lane Graph 
Display can help determine if the peaks on two different graphs represent bands at the same molecular 
weight position (i.e. the same distance from the top of the gel).

To compare peaks on different graphs, roll the mouse over the Lane Graphs. A vertical line which can be 
scrolled across the graphs will appear. The intensity value at the point where the V. Line crosses the graph 
will be displayed. 

Figure 5-46: V.Line Tool Intensity Display

Alternatively, the V. Line can also display hash marks which is a useful tool for comparing peak heights. To 
toggle between displaying intensity values and hash marks when using the V. Line, click the right mouse but-
ton.

Figure 5-47: V.Line Tool Hash Marks Display

NOTE: The hash marks are most useful when only four graphs are shown so that enough detail is dis-
played. To change the Lane Graph display, select the Options menu which is directly above the Data 
Table and deselect Show All Lanes.
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Overlaying Graphs
When comparing the bands in one lane with those in another it is often convenient to display the graphs so 
that one is superimposed over another. After clicking on a graph so that it is enlarged in the image area, select 
the Overlay Control function (from the Data menu) to display the Lane Overlay Control dialog box. In this 
dialog box, specify the lane(s) whose graph(s) should be superimposed and the color and line pattern in 
which they should be displayed. 

• The first column in the dialog box contains the numbers of the graphs which can be superimposed. 

• The second column reports whether or not the graph of a particular lane is currently superimposed. 
These ON/OFF settings toggle back and forth by clicking on them. 

• The colored bar in the third column indicates the color in which a graph will be displayed when it is 
superimposed. To select a color option, click on the color bar until the desired color is shown. 

• The last column in the dialog box specifies the pattern of the line when the graph is superimposed. To 
select a pattern, click on the current pattern until the desired pattern is shown. 

It is especially important to choose different patterns if the graphs will be printed, as differ-
ent colors cannot be distinguished using a gray scale printer.

When the selections have been made, click on the DONE button to dismiss the dialog box and superimpose 
the selected graph(s). (If no graphs have been selected, the dialog box is simply dismissed.) 

Figure 5-48: Three Graphs Overlaid

To turn all graph superimposing off, select the Deselect All button at the bottom of the dialog box.

Bands Tab Overview

Several lane editing and viewing options appear in the Bands tab. Each will be explained in detail in this sec-
tion.
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Figure 5-49: Lane Editing Features

Add Lane
This option allows an additional lane to be placed on the image. To add a lane, select the Add Lane button 
and place the mouse on the image. A plus sign cursor with a new lane grid will display on the image where 
lanes can be added. Roll the mouse over the image to move the cursor to the desired position. When the 
desired position is reached, click the mouse to drop the lane on the image. To add more lanes, move the cur-
sor to another position on the image and click to add the next new lane. Continue until all new lanes are 
added. Click the Add Lane button again to exit the editing mode. The Data Table will readjust accordingly, 
adding the lane and calculating results for the bands within the lane.

Delete Lane
This option allows lanes to be deleted. To delete a lane, select the Delete Lane button and place the mouse 
on the image. A cursor will display on the image. Place the cursor anywhere on the lane to be deleted, then 
click the mouse to delete the lane. Continue until all desired lanes are deleted. Click the Delete Lane but-
ton again to exit the editing mode. To delete lanes when not in editing mode, simply click on the lane and 
select the Delete key on the keyboard. The Data Table will readjust to remove the deleted lane data. 

Move Path
This feature allows for the horizontal manipulation of the center line in each of the found bands. To do this, 
click on the Move Path button. To move the path over a band, position the cursor over the band centroid, 
then click and drag to move the path. To move a lane path, position the cursor over an area in a lane without 
bands, then click and drag to move the lane path. To skew an entire lane path, click on the round end point of 
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the path at the top or bottom of the lane, then click and drag the lane to skew it to the desired position. Click 
the Move Path button again to exit the editing mode. The integrated area of each band will be updated in 
the Data Table as the curve is refigured to match the pixels surrounding the centroid mark.

Add Band
This option allows bands to be added. To add a band, select the Add Band button and place the mouse on 
the image. A plus sign cursor will display on the image. Place the cursor on the band of interest, then click the 
mouse to add the band. Continue until all new bands are added. Click the Add Band button again to exit 
the editing mode. The Data Table will readjust accordingly, and results for the new bands will be displayed. 

Delete Bands
This option allows bands to be deleted. To delete a band, select the Delete Band button and place the 
mouse on the image. A cursor will display on the image. Place the cursor on the band of interest, then click 
the mouse to delete it. Continue until all bands of interest are deleted. Click the Delete Band button again 
to exit the editing mode. To delete bands when not in editing mode, simply click on the band and select the 
Delete key on the keyboard. The Data Table will readjust accordingly, and results for the deleted bands will be 
removed.

Band Filter - Adjusting Peak Detection Parameters
The parameters in the Band Filter box on the Bands tab allow adjustment of the automatic peak finder 
parameters.

Figure 5-50: Band Filter Parameters

There are three attributes that determine whether or not the automatic peak finder recognizes a region of 
the graph as a peak: Minimum Area, Minimum Height and Minimum Width. To apply minimum peak 
find attributes to the analyzed image, select the appropriate checkbox. Either enter a value or click on the 
arrow(s) to adjust the setting. If a value is entered manually, hit the Enter key on the keyboard to apply the 
changes. If a minimum peak find attribute will not be used, deselect its checkbox. 

As each setting is adjusted, the automatic peak finder rescans the graph and defines the peaks based on the 
new settings. A peak is recognized only if it meets the criteria defined in the minimum peak attribute settings. 
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NOTE: Using the Minimum Width control setting is the quickest way to regulate the number of peaks 
detected by the automatic peak finder.

Figure 5-51: Minimum Width is 10

Figure 5-52: Minimum Width is 17

Display Options
These features allow the user to change the visual display of the lanes and bands on the analyzed image. To 
access the dialog box select the Display Options button from the Bands tab.

• The Lane Property box provides the following options: 

• Show Center Line: displays the vertical line which runs through the center of each of the bands. 
• Show Lane Boundary: displays the perimeter of each of the lanes found in the gel (selected by 

default).
• Show Profile Boundary: displays the profile path width in each of the lanes (selected by default).
• Names: the selected radio button will display the lane name by number (Numerical) or by letter 

(Character). 

• Under Band Representation, the Cross selection designates bands with a cross symbol. The Box selec-
tion will display a two-dimensional box around each of the bands. 

• Show Band Properties turns the band property display on/off. The Band Property value to be dis-
played is selected under Band Property.
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• The Band Name Property box allows the user to select what value to display as the bands property. 
The choices are Position (from top to bottom) in Numerals, Position (from top to bottom) in Charac-
ters, Relative Front, Adjusted Relative Front, Molecular Weight Standard or Molecular Weight Calcu-
lated.

 

Figure 5-53: Display Options

Gel Smiling Correction

Options on the Curves tab allows the user to adjust for gel smiling or curvature. Using these tools will 
increase the accuracy of molecular weight calculations and automatic band matching. After gel smiling adjust-
ments have been applied, a new column of data will be generated with an Adjusted Rf. The Rf values reported 
are relative values from 0 to 1 where 0 is the origin and 1 is the lane front without correction for gel smiling 
as commonly occurs in gel electrophoresis. The Adjusted Rf is the corrected value.

Suggestions

The software calculates Adjusted Rf based on the band’s position relative to the nearest gel smiling curve. 
When the band lies between two curves with different curvatures, a weighting is applied where greater 
weight is given to the nearest gel smiling curve. For the most accurate calculations, enough curves should be 
added to properly mimic the curvature of the sample. We also suggest placing at least one curve above the 
top band and below the bottom band in a lane. If these curves are added, the software will use the lane origin 
and front as the first and last curves which are assumed to be straight.
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Applying Gel Smiling Curves

After identifying and editing any lanes or bands, access the gel smiling tools by clicking on the Curves tab.

Figure 5-54: Curves Tab

Add Curve
Select the Add Curve button and then click on the desired area of the image to add a curve line. The curve 
line will have three anchor points: one will be placed at the position of the mouse click on the image and the 
other two will be on either end of the image boundary. Click the Add Curve button again to exit the editing 
mode.
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Figure 5-55: Curve Line Added to the Image

To create the curve, click on any of the three yellow plus sign (+) anchors on the curve line and drag it to the 
desired position. When an anchor has been selected, it will change from a plus sign to a square.

Figure 5-56: Curve After Using Anchors to Adjust the Line

Once a curve has been added, the Adj. Rf values will update in the Data Table, and the following other Gel 
Smiling options are enabled:
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Figure 5-57: Curve Options

Adding and Deleting Anchors
Anchor points can be added by selecting the Add Anchor button. Roll the mouse to the area of the curve 
where the new anchor should be placed. The cursor will change to a plus sign in areas where an anchor can 
be added. Click on the curve to add the anchor. Click the Add Anchor button again to exit the editing 
mode.

Additionally, anchor points can be deleted by selecting the Delete Anchor button. Click once on an existing 
anchor to delete it. Click the Delete Anchor button again to exit the editing mode. To delete anchors 
when not in editing mode, simply click on the anchor and select the Delete key on the keyboard.

Delete Curve
A curve can be deleted by selecting the Delete Curve button. Click on an existing curve to delete it. Click 
the Delete Curve button again to exit the editing mode. To delete curves when not in editing mode, simply 
click on the curve and select the Delete key on the keyboard.

Additional Gel Smiling Curves
Add enough curves to properly mimic the curvature of the sample. The more curves applied, the more accu-
rate calculations will be for molecular weight and band matching. After the initial curve is applied the software 
will attempt to mimic the curvature of the surrounding curves when new curves are applied. This results in 
less editing of the additional curves.
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Figure 5-58: Adding Gel Smiling Curves

Molecular Weight Tab

AlphaView supports molecular weight calculations based on molecular weight standards. Click on the MW 
tab to enter standard values. 

Figure 5-59: MW Tab
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Curve Fit

From the Curve Fit drop-down menu, select the molecular weight standards curve fitting option. The fit 
options are: log, linear, point to point fit, cubic spline and quadratic. 

Import

To apply an existing set of molecular weight standard values select the Import button and select the desired 
*.mwm file. 

NOTE: A set of preconfigured molecular weight standards files (*.mwm files) are installed with AlphaView 
software.

The molecular weight standards file can either be auto loaded or manually loaded. 

Auto Load requires the user to select a lane to apply the molecular weight standard file. After the *.mwm 
file is selected, select YES to Auto Load. Roll the mouse over the image, the cursor will be a yellow line. 
When the yellow line is over the desired standard lane, click on the lane. AlphaView will automatically identify 
each band in the lane and associate it with a molecular weight standard in the imported file. 

Figure 5-60: Molecular Weight Auto Load

Manual load requires the individual bands in a lane to be correlated manually with the standards in the 
imported file. After the *.mwm file is selected, select NO for Manual Load. Move the cursor to the first 
band of interest in a lane and click. Text at the top of the image will indicate how many molecular weight stan-
dards are yet to be identified with a band selection, and what the molecular weight is. Continue to click on 
bands to identify molecular weight standards until all have been identified. 
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Figure 5-61: Molecular Weight Manual Load

Add Molecular Weight Marker

To identify a band as a molecular weight marker, select the Add button. Click on the first band in the known 
standard lane of the image. Enter the marker weight in the dialog box, then click OK.

Figure 5-62: Add Molecular Weight Dialog Box

Continue adding markers until all bands are identified. Click the Add button again to exit the editing mode. 

Delete Molecular Weight Marker

To delete a molecular weight marker, select the Delete button. Move the cursor to the band in the image 
and click to delete it. Click the Delete button again to exit the editing mode. 
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Clear Molecular Weight Markers

To clear all molecular weight markers in a lane, select the Clear button. Roll the mouse over the image. The 
cursor will be a yellow line. When the yellow line is over the desired lane, click on the lane. Once this is done, 
all molecular weight marker information in the lane will be removed. Click the Clear button again to exit the 
editing mode.

Molecular Weight Standards Results Display

After molecular weight standards have been identified, they will be color coded green in the Data Table. The 
curve fit used to calculate results will also be displayed below the Data Table.

Figure 5-63: Molecular Weight Standards Results Display

The calculated molecular weight for each band in the sample will now be displayed in the Calc MW column 
in the Data Table:

Figure 5-64: Calculated Sample Molecular Weight

Export

The set of molecular weight standards used for analysis can be saved for future use. To do this, click the 
Export button. A save dialog box will appear. Enter the name of the file and change the directory location if 
desired. If there are molecular weight standards in more than one lane, a lane must first be selected. To do 
this, roll the mouse over the image and move the yellow line cursor to the lane that contains the markers of 
interest. Click on the lane and save the file.
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Show Molecular Weight Standard Curve

Select the Show Curve checkbox to display the molecular weight standards curve as calculated by the soft-
ware. When this box is checked, the plot will be displayed in the lower right hand corner of the software win-
dow.

Figure 5-65: Molecular Weight Standard Curve

Mass Standards

AlphaView supports mass calculations based on mass standards. Click on the Mass tab to enter individual 
mass standards or apply the total mass for a molecular ladder. 
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Figure 5-66: Mass Standards Tab

Curve Fit

From the Curve Fit drop-down menu, select the mass standards curve fitting option. The fit options are: log, 
linear, point to point fit, cubic spline and quadratic. Curve fits must be specified regardless if the Mass Standard 
or Molecular Ladder option is selected.

Using Mass Standards

To use mass standards, select the Mass Standards radio button on the Mass tab. The following options 
become active. 

Import
To apply an existing set of mass standards, select Import then select the desired *.msm file. 

NOTE: A set of preconfigured mass standard standards files (*.msm files) are installed with AlphaView 
software.

The mass standards file can either be auto loaded or manually loaded. 
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Auto Load requires the user to select a lane to apply the mass standard file to a lane. After the *.msm file is 
selected, select YES to Auto Load. Roll the mouse over the image, the cursor will be a yellow line. When 
the yellow line is over the desired standard lane, click on the lane. AlphaView will automatically identify each 
band in the lane and associate it with a mass standard in the imported file. 

Figure 5-67: Mass Standard Auto Load

Manual load requires the individual bands in a lane to be correlated manually with the standards in the 
imported file. After the *.msm file is selected, select NO for Manual Load. Move the cursor to the first 
band of interest in a lane and click. Text at the top of the image will indicate how many mass standards are yet 
to be identified with a band selection, and what the mass is. Continue to click on bands to identify mass stan-
dards until all have been identified.

Figure 5-68: Mass Standard Manual Load

Add Mass Standard Marker
To identify a band as a mass standard, select the Add button. Click on the first band in the desired lane of the 
image. Enter the mass in the dialog box, then click OK.
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Figure 5-69: Add Mass Standard Dialog Box

Continue adding standards until all bands are identified. Click the Add button again to exit the editing mode. 

Delete Mass Standard Marker
To delete a mass standard, select the Delete button. Move the cursor to the band in the image and click to 
delete it. Click the Delete button again to exit the editing mode. 

Clear Mass Standard Markers
To clear all mass standards in the image, select the Clear button. This will delete all markers in the image. 

Export
The set of mass standards used for analysis can be saved for future use. To do this, click the Export button. A 
save dialog box will appear. Enter the name of the file and change the directory location if desired. If there are 
mass standards in more than one lane, a lane must first be selected. To do this, roll the mouse over the image 
and move the yellow line cursor to the lane that contains the markers of interest. Click on the lane and save 
the file.

Using a Molecular Ladder

To use a molecular ladder, select the Molecular Ladder radio button on the Mass tab. Enter the total mass 
that was loaded into the molecular weight standard lane. Next, roll the mouse over the image, the cursor will 
be a yellow line. When the yellow line is over the desired ladder lane, click on the lane.

Figure 5-70: Molecular Ladder Total Mass Entry
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Mass Standards Results Display
After mass standards have been identified, they will be color coded green in the Data Table. The curve fit 
used to calculate results will also be displayed below the Data Table.

Figure 5-71: Mass Standards Results Display

The calculated mass for each band in the sample will now be displayed in the Calc. Mass column in the Data 
Table:

Figure 5-72: Calculated Sample Mass

Show Mass Standards Curve
Select the Show Curve checkbox to display the mass standards curve as calculated by the software. When 
this box is checked, the plot will be displayed in the lower right hand corner of the software window.

Figure 5-73: Mass Standard Curve
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Advanced Lane Profile Options

Lane Profile also includes two advanced options: Band Scoring and Band Matching. To view these 
options, they must be selected in Preferences. To do this, select Setup and Preferences from the Main 
Menu. Go to the Analysis Tools tab and select the Lane Profile - Advanced checkbox and click 
Apply. 

Figure 5-74: Preferences Analysis Tools Tab

Lane Profile will now display two new tabs for each of the advanced options.

Band Scoring Tab

To perform band scoring, select the Scoring tab.
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Figure 5-75: Band Scoring Tab

Lane #’s to score: Choose the lanes to score by highlighting the lanes to be included.

Score based on: Select the parameter to base the scoring on. The choices are Area, Mass, and Height.   
The Area and Height are calculated automatically in Lane Profile. In order to use the Mass as the scoring 
parameter the user must calculate the Mass of every band by applying a Mass Standard. This can be done sep-
arately or in conjunction with MW calculations.

Select Scoring Method: Select the scoring method of interest. The choices are: Present/Absent; High/
Medium/Low/Absent; % of control; and Quantity.

• Present/Absent: this method is used as a qualitative measurement for review. The researcher is 
interested in whether or not a lane has a specific band of interest based on some criteria (area, mass, 
or height).

• Additional Criteria: When choosing Present/Absent as the scoring method the user must enter a value 
for determining the presence or absence. The value is a percent. When the value of an unknown band 
falls below that percentage value it is classified as Absent, when it exceeds the value it is classified as 
Present.

• High/Medium/Low/Absent: This method is used to classify bands into groups based on Area, Mass, or 
Height. The researcher will determine break points for each classification (high, medium, low, and 
absent). The software will place each band into one of these classifications depending on the user 
entered criteria.
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• Additional Criteria: When choosing the High/Medium/Low/Absent method the user must enter in 
values to use as break points for each of these classifications. The values entered are percentages of 
the reference band based on the parameter chosen in the “score based on” field.

Figure 5-76: Band Scoring - Select Scoring Method

Band Matching, Similarity Matrix, and Dendrograms

AlphaView provides features for matching bands between lanes. The resultant data can then be used to gen-
erate similarity matrices and/or dendrograms. Band matching features are accessible under the Analysis menu 
within Lane Profile’s Auto Lane feature.

Prerequisites for Band Matching
Prior to performing band matching, a number of steps must be followed:

1. Lanes and Bands must be detected and edited through the Auto Lane feature.

2. If Molecular Weights are to be calculated, molecular weight markers must be loaded prior to band 
matching. For more information, please refer to “Molecular Weight Tab” on page 161.

3. (Optional) A new Gel Smiling tool has been added to AlphaView. This tool allows the user to adjust the 
software’s calculations for M.W., Adj. Rf, and Band Matching by drawing the shape of the gel smile or cur-
vature. Applying the Gel Smiling tool will aid in the accuracy of automatically matching bands and will 
result in less user edits afterwards. Refer to the section on Gel Smiling tool for further instructions.



Lane Profile page 173

FluorChem HD2 and FC2 User Guide

Band Matching 
Band Matching dialog window is accessible through the Analysis menu on the Auto Lane’s Profile and Data 
window. Select Band Matching from the Analysis menu.

Figure 5-77: Band Matching Tab

Functionality is provided for both Automatic and Manual band matching. Each will be explained in detail. 

NOTE: These are not exclusive. After Automatic Band Matching has been performed the user is able to 
use the Manual matching features to edit or correct the automatic findings.

Automatic Band Matching

Matching Metric

Select either Adjusted Rf Matching or Generic Rf Matching as the matching metric.

• Adjusted Rf Matching: When Adjusted Rf Matching is selected the software will match bands based 
on the data values in the Adjusted Rf column of the Profile and Data window. These values result from 
the gel smile/curvature rather than the absolute vertical Rf value. Adjusted Rf is calculated based on 
the addition of M.W. markers and/or the Rf Curve lines which serve to correct the Generic Rf values 
for gel smiling.
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• Generic Rf Matching: When Generic Rf Matching is selected the software will match bands based 
on the data values in the Rf column of the Profile and Data window. These values are the relative Rf 
calculated vertically where the origin of the lane is set to zero and the lane front is set to 1. Gel smiling 
or curvature is not adjusted for in this selection.

Matching Reference

Select a lane to serve as the matching reference. It is advised that you choose a lane that either contains most 
of the bands of interest or spans the range of bands of interest while also containing many of the bands of 
interest. This will reduce the amount of effort required for post match edits.

Matching Tolerance

Enter a value to be used as the matching tolerance. The tolerance is converted into the amount of displace-
ment two bands may have and still be matched by the software. The larger the tolerance value the larger the 
range the software will use for matching. The valid range is 0-10%. A value of 1-5% typically works best. A 
lower percentage works well for tightly spaced bands.

Auto Match

After selecting a matching metric, reference, and tolerance click the Auto Match button for the software to 
perform auto matching. When matching has been completed the Display Results and Generate Dendrogram 
buttons will become active. Refer to the appropriate sections below for a description of Similarity Results and 
Dendrogram creation.

Editing Match Results

Following Automatic band matching the user may need to manually edit or correct some matches. The tools 
under Manual Matching can be used for this purpose. Refer to the section below on Manual Matching for a 
description of each tool.

Manual Band Matching

Manual band matching tools are useful for quickly matching lanes with only a few bands or for manual edits 
and corrections to Automatic Band Matching results.
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Figure 5-78: Band Matching Tab

New Band Type

Select the New Band Type tool by clicking the New Band Type button. A Band Type is a band with a unique 
Rf. or Adj. Rf. Value. Each band within a lane will be part of a band type and no two bands within a lane can 
be of the same band type.

After selecting the New Band Type tool, click on a band to draw a band type line. Repeat this process of 
selecting the tool and clicking a band until a band for each unique band type has been selected.

Deleting a Band Type

To delete a band type, select the Delete Band Type button and click on a band type line.

Adding Bands to a Band Type

Select the Plus Band tool by clicking the Plus Band button. Click on a band type line to select it, the line will be 
highlighted in yellow. Now click on a band that belongs to this band type. Repeat this process for all bands 
belonging to this band type. Then repeat the process for each band type until all bands have been identified as 
belonging to a band type.

Removing Bands from a Band Type

Select the Minus Band tool by clicking on the Minus Band button. Click on a band type line to select it, the line 
will be highlighted in yellow. Now click on the band that you would like to remove from the selected band 
type.



page 176 Chapter 5: Image Analysis Tools

FluorChem HD2 and FC2 User Guide

Undo/Redo

The Undo and Redo buttons will undo and redo the last action performed respectively.

Band Matching Results—Display Results
After bands have been matched a table is generated with the matching results. Click the Display Results but-
ton to view the matching results.

Figure 5-79: Band Matching Results Window Displaying the Similarity Matrix

Viewing Result Tables
The match results can be viewed in one of four configurations. Select the configuration desired under the 
View menu. In each view Band Type is identified in the left most column. Band numbers appear in their Rf. 
Position within each lane. Lane numbers are identified in the first row. The file location, matching metric, 
matching reference, and matching tolerance are displayed below the tables.

• Mixed Table—Displays both matched and unmatched bands in one table.

• Separate Tables—Displays matched and unmatched bands in separate tables.

• Matched Table—Displays only the results of matched bands.

• Unmatched Table—Displays only the results of unmatched bands.
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Exporting and Printing Band Matching Results
Print and Export are selectable under the File menu. Select Print to send the report to a local or network 
printer. Select Export to export the results to the clipboard or to file. When exporting to a file there are two 
file types that can be saved, standard text file (*.txt) or a comma separated value file (*.csv). When exporting 
to Excel, use the *.csv file type to skip the Excel import wizard or use export to clipboard followed by Paste 
in Excel.

Dendrogram and Similarity Matrix Generation
After bands have been matched dendrograms and similarity matrices can be generated from the data. Click 
the Generate Dendrograms button to view these.

Figure 5-80: Dendrogram Window

Dendrogram window where Dendrograms are generated and Similarity Matrices are accessed.

Similarity Matrix

Select a method from the Distance Matrix pull down for calculating similarity. The choices are Dice Coeffi-
cient, Jaccard Coefficient, Pearson Coefficient, and Frequency Similarity. These are standard statistical algo-
rithms, references can be found in most statistical text books. 

Select the Display Matrix option from the Options to display the Similarity Matrix.
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Figure 5-81: Similarity Matrix

The similarity matrix is a graphical display of the similarity between lanes.

Exporting and Printing the Similarity Matrix

Print and Export are selectable under the File menu. Select Print to send the report to a local or network 
printer. Select Export to export the results to the clipboard or to file. When exporting to a file there are two 
file types that can be saved, standard text file (*.txt) or a comma separated value file (*.csv). When exporting 
to Excel, use the *.csv file type to skip the Excel import wizard or use export to clipboard followed by Paste 
in Excel.

Dendrograms
The dendrogram window is accessed by clicking the Generate Dendrograms button in the Band Matching dia-
log.

Figure 5-82: Dendrograms
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Distance Matrix

Select a method from the Distance Matrix pull down for calculating similarity. The choices are Dice Coeffi-
cient, Jaccard Coefficient, Pearson Coefficient, and Frequency Similarity. These are standard statistical algo-
rithms, references can be found in most statistical text books. 

Cluster Method

Select a method for calculating the clustering from the Cluster Method pull down. The choices are Neighbor 
Joining, UPGMA, WPGMA, Single Linkage, Complete Linkage, Ward, Median, and Centroid. These are stan-
dard statistical algorithms, references can be found in most statistical text books. 

Clusters

Select the number of clusters you would like displayed in the dendrogram. The values are 1 to maximum 
number of lanes in the image. This option is disabled when Neighbor Joining is chosen for the cluster method 
since the method determines the number of clusters.

OutGroup

When Neighbor Joining is chosen for the cluster method the OutGroup option is enabled allowing the user 
the ability to set the number of Out Groups to display.

Exporting and Printing the Dendrogram

Print and Export are selectable under the File menu. Select Print to send the report to a local or network 
printer. Select Export to export the results to the clipboard or to file. When exporting to a file there are two 
file types that can be saved, standard text file (*.txt) or a comma separated value file (*.csv). When exporting 
to Excel, use the *.csv file type to skip the Excel import wizard or use export to clipboard followed by Paste 
in Excel.

Display Type

Under the View menu the user may select to view the dendrogram in the Phylogram or Cladogram format.

Collapse/Expand 

The Collapse/Expand tool allows the user to collapse or expand the dendrogram by clicking on a red inter-
section marker.

Zoom In/Out Tools 

The zoom in and out tools allow zoom control over the dendrogram window.

Zoom with Selection Tool 

The zoom with selection tool allows the user to zoom an area of interest within the dendrogram defined by 
mouse.

Grab Tool 

The grab tool allows the user to navigate the entire dendrogram in a zoomed display by clicking and dragging 
to window.
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Common Features

Default analysis tool has three common features namely, Protocol, Report, and Export Results.

Protocol

Figure 5-83: Protocol Tab

The Protocol tab is used to save and load protocols for use on replicate blots.

Saving a protocol differs from saving an analysis in that protocols may be used on images other than the orig-
inal image while a saved analysis is available for loading only on the original image.

NOTE: An analysis may be saved at anytime by using the file drop down menu.

Figure 5-84: Saving an Analysis
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A protocol or analysis contains all band and background regions created with the loading controls, band con-
trols and standard curve settings used. A protocol or analysis may be saved at any point in the analysis work-
flow.

Report

Using Report Tab, user can generate reports based on analysis data. Reports offers different options to cus-
tomize the report, which can be saved on file as an Html Format (*.html) or Rich Text Format (*.rtf). User 
can also take print of report.

Reports also allows user to save report settings/configuration as template or can modify existing templates.

Formatting
Formatting tab allows user to format reports before saving or sending it to printer. 

User can create new report or select existing report template to create a report using the drop down list. If 
no report template is defined/saved, it will be disabled.

Choose image that will be part of report with the image size. 1/4 is the default image size. 

Also choose different information (Data sheet, Graph, Acquisition information) that will be part of report.

Report settings/configuration can be saved using Save button, in case of new or Save as in case of modifying 
an existing report template.

Figure 5-85: Report – Formatting Tab
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General
General tab allows user to give report a title, enter analysis notes / comments or give user name.

Clicking Generate Report will create a report based on report settings/configuration.

Figure 5-86: Report – General Tab

Export Results

Once the analysis has completed then there is option to export the result. Either the results can print directly 
to a printer, or export the results as ASCII data for direct importation into Excel or other spreadsheet pro-
grams

Figure 5-87: Common Export Dialog Box
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Sending Data to a Printer
To send the data directly to the Video Printer or Default Printer, click on the Export button and click in the 
circle next to appropriate printer.

Sending Data to a File
If you would like to take the data from the system and import it into another computer, the data can be saved 
to a diskette or network which will allow you to open the data file on a separate workstation connected to 
the network.

Click on the Export button and then on the File option. Specify the path and file name to send the data file. 
The data is saved as an ASCII file and can be imported into most spreadsheet programs.   ASCII is a very 
common file format output option for numerical data.

Appending Data to a Same File
Export dialog also allows you to append data to an existing exported file. 

NOTE: This feature is applicable to AutoCount and Array analysis modules.

Sending Data to a Spreadsheet Program
To send the data results to Excel or other spreadsheet programs, click on the Export button, click on the clip-
board option, then click on OK. If you have Excel or another spreadsheet program loaded on the system and 
running in the background, you can simply press the ALT and TAB keys simultaneously to move into the 
spreadsheet program. You can then import the data directly to the desired spreadsheet from clipboard.

NOTE: The spreadsheet program must be installed on the computer in order to export the data to that 
program.

When the appropriate export source has been selected, click on the OK button to send the data.

Exporting Quantitative Data Lane Profile
The exporting of Lane Profile is similar to what has been defined above with some extra feature.

The Lane Profile has following window to export data.
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Figure 5-88: Lane Profile Export Dialog Box

Output Lane
This option allows user to export what type of data to be exported. Selecting All Lanes will export all lanes 
data or selecting Current Lane will only export current lane data.

To send the data, click on the OK button. 

Additional Analysis Tools
 

Figure 5-89: Additional Analysis Tools in the ToolBox

Additional image analysis tools can be activated to show up under the tool box as shown here. To activate 
these tools:

1. Go to Setup> Preferences > Analysis tools tab.

2. Select tools to show.
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Figure 5-90: Preferences—Analysis Tools Tab

This tool set allows the user to perform ruler measurements, gel scoring, manual counting of colonies and 
cells, and perform high density array analysis.

The Ruler Function

The Ruler function allows the user to create a scale based on a standard and to measure distances from a set 
origin to a chosen location.

Figure 5-91: The Ruler Tools and Ruler Toolbox
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Using the Ruler Function

To access the Ruler function, click on ToolBox, Analysis Tools and then on Ruler. A line with a box at 
each end and a circle with a cross in it will appear on the screen. 

Before any measurements can be obtained, a standard scale must be established. The scale that is created will 
serve as the standard for all measurements. Therefore, it is advisable to draw the scale line according to some 
standard measurement within the image (such as a ruler).

Using the mouse, click and drag one end of the line and then the other end into position. Once the line is in 
position, click in the Scale Length box and type the length of the standard. Press <enter> to save this 
value.

Distance is measured from the origin (designated by the circle with a cross in it) to the mouse location. Place 
the origin marker appropriately, and then move the mouse. The distance will be constantly updated in the 
Distance box.

To hide the scale and origin, click on the Hide Origin Scale checkbox.

Cartesian Coordinates
The Ruler function can also be used to create a Cartesian coordinate system. The origin icon has default val-
ues (0.000, 0.000).   These can be changed by clicking on the Origin box, typing in new values, and clicking 
<enter>.

Once the origin is placed on the screen in its desired location, the relative coordinates of the mouse at any 
location are shown at the right-hand side of the screen. In the example above, the cursor is 0.747 inches to 
the right of the origin and 1.071 inches below. To hide the coordinates, click on the Hide Coordinates 
checkbox.

The Scoring Function

The Scoring function is designed for gene expression applications to check for presence or absence of specific 
samples. The scoring function can be used for a quick manual identification of several different sample types. 
The software allows for up to three different scores on a gel, blot, or microtiter plate.

To score an image, click on the Scoring button in Toolbox 4. Define the appropriate number of rows and col-
umns of your image by using the appropriate controls. You can also define the amount of spacing between 
your rows and columns to compensate for any variations between lanes or wells.



Additional Analysis Tools page 187

FluorChem HD2 and FC2 User Guide

Figure 5-92: Scoring Controls

Once you have selected the number of rows and columns to be displayed, you may adjust the template to fit 
your image. Use the left button on the mouse to click, hold, and drag the outside borders of the template so 
they frame the lanes or wells to be scored. Clicking, holding, and dragging on or within any border moves the 
entire template. Clicking on the blue corners surrounding the template resizes it.

Figure 5-93: Scoring Image with Template Positioned

Scoring the Sample

Three different scoring options are available: score with a positive, negative, or positive / negative. The soft-
ware will display an “X” if you have a positive sample or three “–“ signs arranged in a vertical fashion if you 
score with a negative. Nothing will appear if you score with a positive/negative. You may use the right and left 
mouse buttons to determine different scores. The right mouse button will score the sample with an “X”. The 
left mouse button will score the sample with three “-“ signs vertically arranged. 
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Figure 5-94: Scoring for positives (+), negatives (-), and positive / negative (nothing)

For faster scoring, you may look at the entire image and visually determine whether the samples are primarily 
positive, negative, or positive / negative. By clicking on the All +, All -, or All +/- boxes, all of the samples on 
the image will have either an “X”, three “-”, or nothing depending on the button you clicked. 

Figure 5-95: Image after All+ button pressed vs. Image after All+ button Pressed and Individual Sample Scoring      

Figure 5-96: Output and Scoring Options

Manual Count

Click on Manual Count. The following sets of tools will be displayed in the lower left of the screen. Some 
samples are extremely difficult to count because of their shape, size, or lack of intensity variation from the 
background. To accurately count these samples, we have developed the manual counting feature within our 
software. To manually count the objects in an image, click on Manual Count in Tool Box, Analysis Tools.   
You may use either a green x or a red +. If you are only counting one type of sample, you may simply use the 
x which is the default to begin counting in the software.
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Figure 5-97: Manual Count Tools

Placing Markers to Count

Point the cursor at an object to be counted and click the left mouse button. An “x” is placed over the object, 
ensuring that the same object will not be mistakenly counted twice. In the toolbox, the number in the Count 
box automatically increases by 1. Click on all of the objects of this type or color to be counted.

To count objects of another type or color (such as white vs. blue colonies in a &-gal assay), use right mouse 
button to click on each object as above.

Figure 5-98: Section of an Image After Manual Counting and Corresponding Data

Erasing and Hiding Count Markers

To erase a marker that has been manually placed, click on the marker on the image. It will disappear and the 
count will be reduced by one.

The Sensitivity indicator determines how close the cursor must be to a marker in order to delete it. Higher 
numbers allow the user to click further away from the marker to delete it; however, if Sensitivity is set too 
high, it will be impossible to place markers on spots that are close together.
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Hiding Your Count Markers from the Screen

The software will record all counts as you continue clicking on your objects.   If the counting becomes confus-
ing, you may click on the Hide button to hide off of the x’s and +’s that were used to count your objects on 
the screen.   If you wish to make a print of your image hiding the count, make sure that the Hide button has 
been pressed to high your count markers. You can then go to Tool Box, Enhancement Tools, Anno-
tate, and label the image with the appropriate. Click on the Print button to obtain a hardcopy.

Erasing the Count Markers and Data

Once you have finished counting your objects and have obtained the data you need, you may clear the count 
by clicking on the Zero button. This will erase all of the count markers from the screen and zero the count 
data to allow you to begin counting again with the same image or another image that you have acquired.

Analyzing Arrays

The Array analysis tools (found in the ToolBox, Analysis Tools) make it easy to measure the relative gray 
levels of objects in a uniformly spaced array, such as microtiter plate wells or dot blots. 

These tools allow spot number, orientation and size to be specified. For microtiter plates, two options are 
available: measuring the density within a circle (well), or measuring a central spot and a surrounding torus 
(halo) separately. 

Figure 5-99: ARRAY Toolbox

Once these parameters have been set, a template can be saved in a default file and recalled at a later time. 
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Setting Up an Array Template

To access the Array tools, open ToolBox, Analysis Tools and click on the Array button. A template is 
displayed on the image, depicting the layout of the objects to be measured. Up to 10,000 objects in a 
100x100 array can be measured. (The default is an array of 96 circles, arranged in 8 rows of 12.)

Figure 5-100: ARRAY Template

The tool box work area displays a number of buttons and controls for specifying the number of objects, along 
with their orientation and sizes. 

Analyze Arrays with Circles or Squares

Figure 5-101: Array Dialog Box
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The controls labeled Hori. Wells and Ver. Wells let the number of horizontal and vertical objects be set (to a 
maximum of 100 and 100, respectively). The controls labeled Center and Outer let the size of the center and 
outer circles be set. Click on an arrow to increase or decrease the number of objects per row or column, or 
the size of the objects. As the number and size are adjusted, the template displayed over the image is updated 
to reflect the changes.

Aligning the Template

Once the number of objects has been set, adjust the placement of the template. 

If the image of the sample is not parallel with the template, the template can be realigned by adjusting the 
green line so it is parallel to the top edge of the sample. Place the cursor on the box at either end of the line. 
Hold the left mouse button down and drag the line until it is parallel to the image.

Next, adjust the placement of the template so the objects coincide with the areas of interest on the image. 
Move the cursor to any of the square “handles” on the outside of the template. Hold down the left mouse 
button and drag the handles until the template is properly positioned.

If the image is not perfectly rectangular, the template can be skewed by clicking the Skewing checkbox.

Figure 5-102: A Skewed Template
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Specifying the Areas to Be Measured

For microtiter plate analysis, the toolbox controls labeled Center and Outer specify the size of the inner circle 
and outer torus scanned to measure each well. The number in the center of each of these controls indicates 
the diameter of the circles. Click on an arrow to increase or decrease the diameters. As the number is 
adjusted, the objects on the template grow larger or smaller, reflecting the changes.

When specifying the size of the area to be measured, exclude shadows or other imaging artifacts. Depending 
upon the lighting conditions when the image was captured, there may be a crescent-shaped shadow obscur-
ing part of the bottom of the wells, especially those near the edge of the microtiter plate. We recommend 
decreasing the size of the sampling area so that these regions are not included.

To measure the total density within each object, reduce the Center value to zero (0) and adjust the Outer 
value until the objects on the screen are slightly smaller than the areas of interest on the image. Reposition the 
corner objects using the mouse until the objects are properly aligned over the objects.

Measuring Density

Once the objects are sized and positioned correctly, click on the Scan button in the tool box. The density 
values will be calculated and displayed under each object. 

The values are the average pixel values within the object, adjusted to a scale of 0 to 100. (0 corresponding to 
black pixel values, and 100 corresponding to white pixel values.)

If both a center and an outer circle have been specified, two values are displayed. The upper value corre-
sponds to the inner circle and the lower value corresponds to the torus.

The Invert Box

The Invert function reverses the relative density assignments so that 0 corresponds to white and 100 corre-
sponds to black. If the image has dark areas of interest on a light background, then Invert should be selected 
by placing an “X” in its box. (If the image has light areas of interest on a dark background, the Invert option 
should not be activated.) Unlike the Reverse option described in “The Reverse Button” on page 47, this 
function does not alter the appearance of the image.

Removing Background Using the Scan Blank Function 

Since a microtiter plate is not completely transparent, it contributes to the density measured when samples 
are scanned. A non-uniform light source also affects the density measured. To ensure that the density mea-
sured is attributable only to the sample in the wells, scan a “blank” before scanning samples. 

Load an image of a clean, unused microtiter plate and align the objects as described above. Once the array 
has been set up, click on the Scan Blank button. The average pixel gray value for each object (and torus) is 
measured and set to zero (0). 
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Now, when samples are scanned, the gray value of the blank is subtracted from that of the sample before it is 
scaled. This ensures that the density reported only reflects the sample in each well.

When Scan Blank has been selected, the background values obtained apply to all subsequent scans. To indi-
cate that a background is being applied, the Scan Blank button changes to read Clear Blank. To turn off this 
background subtraction function, simply click on Clear Blank.

Lane Profile - Advanced

When the Lane Profile - Advanced checkbox is selected, Band Scoring and Band Matching tabs are 
added to the Lane Profile options in the Analysis Tools tab of the Toolbox. For complete details, please 
see “Advanced Lane Profile Options” on page 170.

Common Export Result Feature

Once the analysis has completed then there is option to export the result. Either the results can print directly 
to a printer, or export the results as ASCII data for direct importation into Excel or other spreadsheet pro-
grams

Figure 5-103: Common Export Dialog Box

Sending Data to a Printer
To send the data directly to the Video Printer or Default Printer, click on the Export button and click in the 
circle next to appropriate printer.

Sending Data to a File
If you would like to take the data from the system and import it into another computer, the data can be saved 
to a diskette or network which will allow you to open the data file on a separate workstation connected to 
the network.

Click on the Export button and then on the File option. Specify the path and file name to send the data file. 
The data is saved as an ASCII file and can be imported into most spreadsheet programs.   ASCII is a very 
common file format output option for numerical data.
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Appending Data to a Same File
Export dialog also allows you to append data to an existing exported file. 

NOTE: This feature is applicable to AutoCount and Array analysis modules.

Sending Data to a Spreadsheet Program
To send the data results to Excel or other spreadsheet programs, click on the Export button, click on the clip-
board option, then click on OK. If you have Excel or another spreadsheet program loaded on the system and 
running in the background, you can simply press the ALT and TAB keys simultaneously to move into the 
spreadsheet program. You can then import the data directly to the desired spreadsheet from clipboard.

NOTE: The spreadsheet program must be installed on the computer in order to export the data to that 
program.

When the appropriate export source has been selected, click on the OK button to send the data.
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Opening AlphaView Files in Other 
Software Programs

Appendix Overview
• Viewing AlphaView Images

• Using ResEdit
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Viewing AlphaView Images 
Cell Biosciences generated files have been tested in the software packages below. For successful imports, the 
command line is given. 

Programs for the Macintosh> operating system were tested on a PowerMac> 8100/100AV. Results may vary 
for different software versions and/or hardware configurations.

Table A-1: Viewing AlphaView Images - Programs and File Type Requirements. *For instructions on using ResEditA, see next
page.

Additional packages, such as Claris Works and PowerPoint have also been tested. For these systems, it is nec-
essary to save the file with a “.TIFF” extension in order for them to recognize the file as a TIF format. 

If you have a specific software package that is not listed here, contact Cell Biosciences. This PC-formatted disk 
contains a gel image saved as five of the file types that AlphaView can generate. Try opening each of these files 
in your software package to determine compatibility. We recommend that you start with the .TIF file, as this is 
the default Cell Biosciences file format.

Using ResEdit
1. Save image in IS-1000/500 as a TIFF or MACTIFF.

2. Obtain a copy of the free ware ResEdit by downloading from Apple Computers through the Internet. 

3. Open ResEdit. 

An animated startup display will show up and continue until you click on the mouse or any key.

.TIF .BMP .GIF .MAC .PCX

Adobe Photoshop 2.51 LE (Mac) Open no Open Open As/TIFF no

Adobe Photoshop 3.0 (Mac) no Open Open

Canvas 3.5 (Mac) use ResEdit* no no use ResEdit* no

Microsoft Word 6.0 (Mac) Insert Picture Insert Picture no Insert Picture no

Microsoft Word 6.0a (Win) Insert Picture Insert Picture no Insert Picture Insert Picture

Microsoft Excel 5.0 (Mac) no no no no no

Microsoft Excel 5.0c (Win) Insert Picture Insert Picture no Insert Picture Insert Picture

NIH Image 1.59 (Mac) Open no no Open no
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A dialog box will appear.

4. Open the TIFF image. 

Another dialog box will appear asking if you want to add a resource fork.

5. Click OK.

6. Click File > Get Info for This File.

7. In the File Info window, change the Type to TIFF (instead of TEXT), and the Creator to DAD2 (instead of 
DOSA). (Must be typed in all CAPS as shown here). 

8. Close the window and save changes. 

9. Quit ResEdit.

After this procedure, the icon will change to a TIFF icon and the file may be opened in Canvas. 
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List of Standards
A library including the following DNA, RNA and protein molecular weight standards has been incorporated 
into AlphaView. 

Values of size standards are given in base pairs. 

Table B-1: AlphaQuant Standards

AlphaQuant 
1

AlphaQuant 
2

AlphaQuant 
3

AlphaQuant 
4

AlphaQuant 
5

AlphaQuant 
6

AlphaQuant 
7

10000 2000 5000 1000 500 2000 5000

8000 1800 4500 800 400 1000 3000

6000 1600 4000 700 300 500 2000

5000 1400 3500 600 250 250 1000

4000 1200 3000 500 200 100 500

3000 1000 2500 400 175

2500 800 2000 300 150

2000 700 1500 200 125

1500 600 1000 100 100

1000 500 700 75

800 400 500 50

600 300 25

400 200

200 100

50
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Table B-2: DNA Sizing Standards

DNA Size Standards (in bp)

HINDIII PHIX174 BRL10BP BRL50BP BRL100BP PRO100BP BRL123BP BRL1KB BRLHIMW

23130 1353 200 500 1500 1500 4182 12216 48502

9416 1078 190 450 1400 1000 4059 11198 38416

6557 872 180 400 1300 900 3936 10180 33498

4361 603 170 350 1200 800 3813 9162 29942

2322 310 160 300 1100 700 3690 8144 24776

2027 281 150 250 1000 600 3567 7126 22621

564 271 140 200 900 500 3444 6108 19399

125 234 130 150 800 400 3321 5090 17057

194 120 100 700 300 3198 4072 15004

118 110 50 600 200 3075 3054 12220

72 100 500 100 2952 2036 10086

90 400 2829 1636 8612

80 300 2706 1018 8271

70 200 2583 517

60 100 2460 396

50 2337 344

40 2214 298

30 2091 220

20 1968 201

10 1845 154

1722 134

1599 75

1476

1353

1230
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Table B-3: RNA and Protein Standards

HINDIII PHIX174 BRL10BP BRL50BP BRL100BP PRO100BP BRL123BP BRL1KB BRLHIMW

1107

984

861

738

615

492

369

246

123

RNA Size Standards Protein Markers (in kD)

BRLRNA1 BRLRNA2 BRLPROT1 BRLPROT2 BRLPROT3 BRL10KD NOVEXM12 SIG-
MAHMW

SIG-
MAPMW

1770 9490 87.0 200.0 43.0 200 200.0 205 190

1520 7460 60.0 97.4 29.0 120 116.3 116 108

1280 4400 53.0 68.0 18.4 110 97.4 97 89

780 2370 46.0 43.0 14.3 100 66.3 84 77

530 1350 40.0 29.0 6.2 90 55.4 66 61

400 240 34.0 18.4 3.0 80 36.5 55 41

280 29.0 14.3 70 31.0 45 36

155 27.0 60 21.5 36

21.0 50 14.4

15.0 40 6.0

6.5 30 3.5

20 2.5

10

DNA Size Standards (in bp)
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Single Channel Columns

Region Tab

Band Band Identifying Number

Sum Sum of all pixel gray levels in Band 

Percentage (%) Percentage Sum =(Sum/ Total of all Band Sums)*100

Area Area of Band Region in pixels

Average Average pixel level of Band = (Sum/Area)

X Y Position   XY position of Band Region centroid

SD Pixel Levels   Standard Deviation of pixel gray levels in Band 

Background Tab

BC Sum Background Corrected Sum   = (BC Average *Area)

BC Average    Background Corrected Average = (Average – Bkgd Average)

Note Subtracting the Bkgd Average from the Average accounts for differences in area

Bkgd Sum      Sum of all pixel gray levels in Background Region

Bkgd Area Area of Background Region

Bkgd Average Average pixel level of Background region = (Bkgd Sum /Bkgd area)

Bkgd XY            X Y position of Background region

Bkgd SD          Standard deviation of pixel gray levels in background region

Signal/Noise    Signal to Noise ratio of the band region = (Average– Bkgd Average) /Bkgd SD

Control Tab

LCN Sum Loading Control Normalized Sum = (LCN Average* Area)

LCN Average Loading Control Normalized Average = (BC Average of Experimental Band/BC Aver-
age of corresponding Loading control) * mean of all loading controls.

NOTE: If a background correction has not been applied, Average is used.
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LC Regions Specifies the channel and region number used for each Experimental Band and corre-
sponding Loading Control, (e.g. Red1/ Green 12)

PCN Sum Positive Control Normalized Sum=(NCN Average *Area)

PCN Average Positive Control Normalized Average = (LCN Average of experimental band / LCN 
Average of control band) *100.

Note If loading controls have not been applied, BC Average is used. If a background correc-
tion has not been applied, Average is used.

PC Regions Specifies the channel and region number used for each Experimental Band and corre-
sponding Band Control, (e.g. Red1/ Red 6)

Fold Change Fold Change of experimental band relative to control

NOTE: If LCN Average experimental band >LCN Average control band then fold change = LCN aver-
age experimental/LCN average control. If LCN Average of the experimental band   < LCN Average of 
control then fold change = (-1) * 1/(LCN average experimental / LCN average.

Std Curve Tab

“ng” Values of Band region in Std curve in units as defined
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Bias and Darkmaster File Generation
The system is shipped with a set of darkmaster and bias files that meet the requirements of most commonly 
encountered imaging applications (1, 4, and 8 mins). Some applications, however, such as extremely low-level 
signal detection with lengthy exposure times may benefit from generating specific darkmaster files matched to 
the exposure time of the application for optimum performance. The AlphaView software includes a utility for 
generating bias and darkmaster files. 

NOTE: A darkmaster for a given time need only be constructed once. Subsequent imaging applications will 
then apply the optimum darkmaster from the set of all darkmasters in the system.

CCD images exhibit a non-zero black level (bias) and temperature/time dependant levels (primarily thermally 
generated electrons called dark current) which are typically quite stable and can be corrected. Once there 
levels are characterized they can be removed from the image under consideration. This process is uniformly 
referred to as image calibration (along with flat field correction) to produce an image that contains only signals 
from the object under test and some residual noise from the original error sources.

The minimum requirements for accurate determination of bias and dark current levels is thermal stability and 
light tightness. Any fluctuations in temperature will alter the bias and dark current levels. Any light leaks will 
result in an additional source for errors that will not be correctly removed from images under consideration.

Bias and darkmaster files are created by collecting a set of 16 images that are combined in such a way to 
reduce the noise levels and reject spurious signals (such as cosmic rays, etc). A set of such files for darkmas-
ters are created at different exposure times to create a library of darkmaster files. The files are logged into the 
program folder and used for all subsequent imaging sessions.

When an object is imaged, the exposure time of the image is used to select the darkmaster with a similar 
exposure time and the darkmaster is scaled such that the dark current levels match that of the image under 
consideration. The bias and scaled darkmaster files are then subtracted from the image under consideration 
which results in an image with no bias (offset or black level errors) and elimination of dark current signals. As 
with any calibration method there are still noise artifacts that remain in the image after correction. At the time 
of acquisition an image contains the actual bias level plus bias level noise (also called read noise) in addition 
there is the dark current signal and its noise signals. The bias and darkmaster calibrations remove the bias and 
dark current signals but the noise from those signal remains (other techniques must be employed to address 
the residual noise-like frame averaging).

The best darkmaster images will have a similar exposure time to that which is typically used. The utility allows 
building darkmaster files of any exposure time (in 1 minute increments) so a darkmaster with a time that 
matches the typical exposure time can be constructed. It is best to have the darkmaster exposure time be 
greater than the time of interest. For example, if 4.5 minutes is a typical time then a 5 minute darkmaster 
would be best. Shorter or much longer times will still work, but optimal dark current correction occurs when 
using darkmaster exposure times greater than the test image exposure time (but no too much longer-round 
up to the next highest minute).
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To use the utility to construct bias and darkmaster files, perform the following steps:

1. Allow camera to reach temperature and stabilize (at least 30 minutes after power on is recommended).

2. Put a cap on the lens mounting plate to block all light from the camera head. A lens cap will leak light. 
Creating darkmaster file with the camera and lens mounted to a cabinet is not recommended. If the 
camera cannot be dismounted then close the aperture and position the most opaque filter under the 
lens and turn off the cabinet before proceeding.

3. Access the utility from the application menus; see Figure D-1.

Figure D-1:  Setup Menu Options

4. Log in to the utility (call tech support for the password).

Figure D-2:  User Login

5. Enter the times for darkmaster files creation separated by commas.
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Figure D-3: Bias and Darkmaster Generator

If bias files do not exist, they are created automatically. If only bias files are desired, enter a time of 0 minutes. 
Notice that the times to create the calibration images are quite long so please plan accordingly. 

The estimated time of completion is given.

 

Figure D-4: Bias and Darkmaster Generator—Time Set

A final notice is given when the process is complete.
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Appendix E:

Flat Field Calibration

Appendix Overview
• Introduction

• Calibration Procedure
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Introduction
The flat field calibration procedure is performed at installation or at the factory. Flat field files are provided for 
the most commonly encountered imaging situations. The purpose of the flat field calibration is to remove 
significant illumination and detection path non-uniformities from acquired images. Properly calibrated 
fluorescent images will be uniform for accurate quantification of signals levels within 5% at any position in the 
image. 

A flat field calibration is only valid for images acquired under identical imaging conditions specific to that flat 
field file (not including exposure time or binning factor). A specific flat field file calibrates both the illumination 
intensity field and the image formation optics (lens and filter) and sample position within the cabinet. 
Consequently any change to either the illumination field or the imaging optics will degrade the calibration. 
Examples of such changes are positioning the sample at a different level within the cabinet, changing lens focus 
and aperture settings, replacing filters, or repositioning the camera and lens bracket.

The flat field calibration is applied automatically as part of the image acquisition process when a matching flat 
field is present in the application directory (C:\Program Files\name of system). If a matching flat field file is not 
present, then a flat field calibration is not applied. Also the flat field calibration may be disabled in the camera 
setup and preview window during acquisition.

The flat field image naming convention follows the format “FlatNxM.tif ” where N is an index that lists the 
excitation light source and M is an index that lists the emission filter wheel position.

Calibration Procedure
Flat field calibration is appropriately utilized when no changes are made between flat field calibration and the 
imaging of biological samples.

The appropriately named flat field file will be placed in the application directory and subsequently applied to 
image acquisition at those illuminations and filter settings. The flat utility applies a smoothing function to the 
acquired image to remove irregularities due to mottling or fibers in the paper. 

1. Place a uniform target such a piece of white laser printer paper at the sample location that will be used 
for fluorescent imaging.
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Figure E-1: Flat Field Target Inside System

2. Focus on the surface of the flat target (paper target shown below). 

NOTE: It is important to set lens focus and aperture settings to those to be used for image acquisition.

 

Figure E-2: Flat Field Target Image Example

3. Acquire a grayscale image of the target with the desired illumination and filter settings. Use the top speed 
resolution setting possible (Normal/Ultra) and Zoom ROI setting = 1. The image should be generally 
bright with pixel gray levels between 50% and 90% of saturation (intensity values = 30,000 - 58,000). A 
few saturated (red) pixels are allowed.
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Figure E-3: AlphaView Screen Shot Example

4. Select Flat Field Utility from the Setup > System Calibration menu.

Figure E-4: Flat Field Menu Path

5. Complete the login screen security entry. The default is provided below:

User name: master

Password: master

 

Figure E-5: Security Login Screen
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6. Image selection screen—review images created for flat field calibration. Images shows should match 
images acquired for flat field calibration.

Figure E-6: Flat Field File Image Selection

7. Select OK (or follow instructions).

 

Figure E-7: Confirmation of System Containing Flat Field Master Image

8. Select OK. Flat field calibration is now complete

 

Figure E-8: Confirmation of New Set of Flat Field Master Images Created
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Cell Biosciences, Inc.
3040 Oakmead Village Drive
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Toll-Free: (888) 607-9692
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